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Overview

Introduction

The Reporter Guide provides information required to 

� collect and store Operational Measurements

� generate reports and alerts

� analyze and interpret report data 

Assumptions

This guide assumes that the CallPilot server has been correctly installed an
operational. If the application has not been installed, then install it before 
proceeding. For installation instructions, refer to the hardware installation gu
appropriate to your server type.

If the server has been installed but is not operational, refer to the Installation and 
Configuration Guide for information on troubleshooting your system.

Skills you need

Nortel Networks product knowledge
Knowledge of, or experience with, the following Nortel Networks products is
helpful:

� Meridian 1

� Meridian Mail

PC experience or knowledge
Knowledge of, or experience with, the following PC products is helpful. For 
more information on these products, refer to the documentation provided by
manufacturer:

� Microsoft Windows NT, 95, 98
14 CallPilot
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Other experience or knowledge

Other types of experience or knowledge that might be useful include

� network management

� client server systems
Reporter Guide 15
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About Reporter

Introduction

Reporter is a software program that helps you analyze and manage your 
CallPilot system. Reporter converts raw statistics (Operational Measuremen
from your server into easy-to-read reports. These reports can help you with
following tasks:

� Establish a pattern of normal system behavior.

� Monitor system usage.

� Detect potential system problems.

� Assess your system’s overall efficiency.

� Monitor system security.

� Bill users for service usage.

� Plan for future enhancements.

� Track changes made by an administrator.

Three components of Reporter

Reporter is made up of three programs that are installed on the PC client:

� Reporter Download Schedule (installed on the server)

� Nortel Reporter (installed on the PC client)

� Communicator (installed on the PC client)

The Reporter Download Schedule is only accessible if you are connected t
server and have permission to access it.

Reporter Download Schedule
Reporter Download Schedule lets you specify the time at which Operationa
Measurements are copied from the CallPilot server to your PC client. To en
that data is downloaded regularly, you can use Reporter Download Schedu
set up a download schedule. If you want to collect data on demand, you can
use this program to perform an unscheduled or “immediate” download.
16 CallPilot
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To use Reporter Download Schedule, you must have valid security access 
CallPilot server. If Reporter Download Schedule appears as an icon in the N
CallPilot Administration Client, you have reporting access for the server. If t
icon does not appear, you do not have reporting access for the server. 

Note: Access to the CallPilot server is defined in the Access Classes progra
Ask your system administrator to give you the correct permissions.    

Nortel Reporter 
Nortel Reporter organizes the raw operational measurements downloaded 
the server into different types of reports. When you download operational 
measurements from the server to your PC client, you can generate reports 
analyze data without tying up your server’s resources.

Use Nortel Reporter to

� print reports on a daily, weekly, or monthly basis

� export reports to a variety of file formats

� customize a report’s data
Reporter Guide 17
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Communicator

Communicator controls the network link between the CallPilot server, your 
client, and the printer. This allows Communicator to coordinate downloads f
multiple servers and manage print jobs. 

Communicator starts automatically whenever you start your PC client. To s
room on your screen, you can minimize and display the Communicator win
as an icon on the Windows status bar. 
18 CallPilot
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Note: Communicator must run 24 hours a day for successful downloads an
print jobs to take place. Do not shut down the PC on which Communicator 
running.
Reporter Guide 19
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How Reporter creates reports

Introduction

Reporter uses the raw data provided by Operational Measurements (OMs) 
generate reports. Operational Measurements are statistics that provide valu
information about the way your server is being used. Some OMs, for examp
show how frequently system resources are being used. Other OMs trace 
individual phone calls as they are processed by the system. 

How reports are created

There are four stages to creating reports:

1. The server collects OMs.

2. OMs are downloaded to your PC client. Reporter Download Schedule an
Communicator work together to control the download process.

3. Nortel Reporter converts downloaded OMs into reports.

4. Reports are printed.

OMs are collected by the server
Before the CallPilot server can collect OMs, you must specify the type of O
data you want to collect, the interval at which it is collected, and the length 
time it is stored.

OMs are downloaded to your PC client
Once OMs have been collected by the server, you can copy them to your P
client. Reporter Download Schedule and Communicator work together to 
control the download process. OMs are downloaded to your PC client using
either a LAN (Ethernet) connection or a PPP (modem) connection.
20 CallPilot
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OMs are converted into reports
Once OMs have been downloaded to your client, Nortel Reporter organizes
information into different types of reports. For example, OMs related to 
messaging activities are converted into messaging reports; OMs related to 
networking are converted into networking reports.

Reports are printed
Reports can be printed on a regular basis according to a preset print sched
they can be printed on demand. When you set up a print schedule, you can
the results of your reports over a period of time. This can help you identify 
patterns and trends related to system usage. 

Multiple servers

If there is more than one server in your organization, you can collect data fr
each server and download it to a single PC client. This helps you centralize
reports created by Nortel Reporter. You can download OMs from up to 50 
servers to a single client.

Generating reports for multiple servers 

Reporter Download Schedule
and Communicator download
OMs from each server to the
PC client (via LAN or PPP
connection).

Server 1

Printer

Server 2

Each server
collects OMs. PC Client

Nortel Reporter converts OMs
into different types of reports

Reports are printed.
Reporter Guide 21
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What’s new in this guide

Administration report

The Administration Action report is new for this release. This report provide
information about the changes performed by administrators. It also gives a 
explanation of the action and the items affected by this action.

For detailed information about this report, see Chapter 6, “Administration 
reports.”

System status reports

The Service Quality Detail report and the Service Quality Summary report a
available for the M1 switch only.
22 CallPilot
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Related information products

Introduction

The following list of CallPilot technical documents are stored on the CD-RO
that you receive with your system. You can search the entire suite of 
documentation online, or you can print part or all of a guide. 

Planning and engineering guides

Use these guides before you install CallPilot to help plan your system, and 
plan a migration of data from Meridian Mail to CallPilot. 

Installation and configuration guides

These guides describe how to install hardware and software for the CallPilo
server, client, and desktop messaging. Instructions for configuring the switch
also provided.

Document Title

Planning and Engineering Guide

Meridian Mail to CallPilot Migration Utility Guide

Document Title

200i Installation and Configuration Guide

702t Installation and Configuration Guide

1001rp Installation and Configuration Guide

Desktop Messaging Software Installation and Maintenance Guide
Reporter Guide 23



Getting started with Reporter  Standard 1.0

t, 

king 
Administration guides

These guides provide specialized information to help you configure CallPilo
administer and maintain it, and use its features. 

Networking guides

These guides describe how to plan, install, set up, and troubleshoot networ
services. 

Document Title

Getting Started Quick Reference Card

Administrator's Guide

Reporter Guide

Application Builder Guide

Monitoring and Security for the Administrator

Document Title

Network Planning Guide

AMIS Implementation and Administration Guide

Integrated AMIS Implementation and Administration Guide

NMS Implementation and Administration Guide

Enterprise Implementation and Administration Guide

VPIM Implementation and Administration Guide
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End user guides

These guides are intended for end users of CallPilot, such as phoneset use
desktop messaging users.

Using the online Help, guides, and tutorials

CallPilot contains three online sources for information:

� Online Help provides brief answers to the questions “What’s this?” and
“How do I...?”

� Online guides provide detailed conceptual information, as well as 
information on how to perform detailed tasks.

� Online tutorials provide a complete product overview, as well as specifi
information on how to use Application Builder.

You can access all information using either the Help menu or Help buttons.

Contacting Technical Support

Contact your distributor’s technical support organization to get help with 
troubleshooting your system.

Contacting Nortel Networks

If you have comments or suggestions for improving CallPilot and its 
documentation, contact Nortel Networks at the following web site address:

http://www.nortelnetworks.com/callpilot_feedback

Document Title

Multimedia Messaging User Guide

Speech Activated Messaging User Guide

Desktop Messaging Quick Reference Guide
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Overview of Operational Measurements

Introduction

Operational Measurements (OMs) are statistics that provide Reporter with 
valuable information about the way your CallPilot system is being used. So
OMs provide detailed information about phone calls processed by the syste
Other OMs provide general information about system resources, such as d
space and channel usage.

How  Reporter uses OMs

Before Reporter can use the information provided by OMs, you must set up 
server to collect and store OM data. Once OMs have been collected,  Repo
can download them to your PC client and turn them into reports.

Server 1

Server 2

Each server
collects OMs

PC Client

OMs are stored in
the server database.

OMs are downloaded from
the server database to the

corresponding PC database.

PC Client database
stores OMs from

Server #1.

PC Client database
stores OMs from

Server #2.

OMs are stored in
the server database.
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About collecting OMs

Introduction

To collect OMs from the server, you must specify

� the types of OMs you want to collect 

� the interval at which OMs are collected

� the length of time OMs are stored on the server

Types of OMs

The CallPilot server can collect three types of OMs—Billing, Traffic, and Tra

� Billing OMs provide Reporter with detailed information about each call 
handled by the CallPilot system.

� Traffic OMs provide Reporter with summarized information about callin
activity and system usage. 

� Trace OMs provide Reporter with information about the Speech Activa
Messaging service.

To use Reporter effectively, you must collect all three types of OM data. Thi
ensures that you can generate all reports. 

Collection interval

The server can collect OM data 24 hours a day, or once a day during a spe
period. You might want to collect OMs 24 hours a day if your company rece
faxes or phone calls from international locations, or if you are concerned ab
hacker activities during nonbusiness hours. 

If you do not want to collect OMs 24 hours a day, you must decide on an 
appropriate interval for data collection. If your business is open from 9:00 a
to 5:00 p.m., for example, you can collect OM data only during those hours
Reporter Guide 31
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Storage interval

The server automatically stores OM data for one to seven days. If you want
keep data on the server for a different length of time, you can specify a stor
period of one to ten days.

Stored OM data affects the amount of disk space available on your server. 
your free disk space is below 20 percent, storing OMs for ten days can redu
server performance. If you notice a slow response from the server, reduce t
number of days for which data is stored.
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Collecting OMs

Introduction

Before the server can start gathering OM data, you must specify the type of
you want to collect, the interval at which it is collected, and the length of tim
is stored on the server.

Before you begin

To use Reporter effectively, you must collect all three types of OM data. Thi
ensures you can generate all reports.

If you do not want to generate reports, choose None from the Select type of
list. This prevents OMs from taking up space on the server.

Getting there  Exploring - CallPilot Administration Client > CallPilot System > System 
Administration > System Performance Monitoring > Operational 
Measurements 
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To collect OMs

1 From the Data Collection Type list, select Trace, Traffic & Billing.

2 If you want to collect data 24 hours a day, click 24 hours a day, and then go 
to step 6.

3 If you want to collect data for part of the day, click Time Interval. 

4 In the From box, type the start time for data collection. 

5 In the To box, type the end time for data collection.

6 In the Keep data on server box, type the number of days for which data is 
stored, or accept the default.

Note: You can store data for one to ten days.

7 Click Save to return to the CallPilot Administration Client.
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 Overview of downloading OMs 36

 Understanding scheduled downloads 38

 Understanding unscheduled downloads 40

 Setting up a download schedule 41

 Checking a server’s next download time 45

 Performing an unscheduled download 47
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Overview of downloading OMs

Introduction

Once OMs have been collected by the server, you can download them to yo
client. OMs are downloaded using either a LAN (Ethernet) connection or a 
(modem) connection. 

 Scheduled and unscheduled downloads

To ensure that OMs are downloaded regularly, you can set up a download 
schedule for your server. If you want to download OMs on demand, you can
perform unscheduled or “immediate” downloads. For more information on 
scheduled and unscheduled downloads, see the remainder of this section.

Storing downloaded OMs on your PC client

The first time you set up a download schedule for a server, an empty datab
automatically created on your PC hard disk. OMs are stored in this databas
a maximum of 180 days before they are overwritten. If you are downloading
OMs from multiple servers, one database is created for each server. For mo
information about the OM database, see Section C: “Maintaining the client OM 
database,” on page 51.
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Specifying a location for the OM database
When you set up a download schedule for the first time, Reporter suggests
default directory for the new database on drive C of your PC client. If you w
to change the location of the database, you can select a different drive. Onc
have specified a new drive, you cannot change the location.

OM database size
The longer you store OMs, the more space the OM database takes up on y
client. You can dedicate an entire drive to the OM database, if required.
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Understanding scheduled downloads

Introduction

Before Reporter can generate reports, you must download OMs from the 
CallPilot server to your PC client. When you set up a download schedule, y
ensure that OMs are copied from the server to your client regularly. Schedu
downloads occur once every 24 hours and retrieve the previous day’s data 
the server. 

Scheduling downloads for multiple servers

If your organization has more than one server, you can download OMs from
each server to a single client. This helps you centralize the reports created 
Reporter. You can download OMs from up to 50 servers to a single client.

When scheduling downloads, make sure that your schedules do not overlap
Overlap in your download schedules results in download failure.

Preventing overlap in download schedules
To prevent overlap in your download schedules, ensure that each server ha
enough time to complete its download before the next one begins. The estim
download time, provided by the Reporter Download Schedule, can help you
determine how long each download will take. For example, if your first 
download is scheduled for 1:00 a.m. and the estimated download time is tw
hours, you should not schedule another download until 3:00 a.m.

Guidelines for scheduling downloads

When scheduling downloads, keep the following in mind:

� Schedule OM downloads during nonbusiness hours when network acti
is low. Make sure your downloads do not conflict with other activities th
take place during nonbusiness hours (for example, backups or audits).

� Do not overlap your download schedules. Overlap in your schedules ca
download failure.
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� The total time it takes for all servers to download to the same client can
exceed 24 hours. If the total download time is greater than 24 hours, yo
must remove one or more of the servers from your download schedule

� The estimated download size for each server cannot exceed the amou
space available on your PC client. If this occurs, free up space on your d
by removing unnecessary files, or remove one or more servers from th
download schedule.

� Do not download OMs from more than 50 servers to a single client.

� Make sure your download schedule does not conflict with your print 
schedule. If you download OMs while Reporter is trying to print reports
the reports will not contain any data.
Reporter Guide 39
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Understanding unscheduled downloads

Introduction

If you want to download OMs without setting a download schedule, you can
an unscheduled or “immediate” download. You can run an immediate down
to

� collect OMs if a scheduled download has failed

� view the most recent OMs collected by the server

� view OMs collected by a server that does not have a regular download
schedule

� check if there is a problem with your system that requires you to have d
ahead of schedule

Guidelines for performing an unscheduled download

Do not run an unscheduled download during the following times: 

� while another download is in progress 

� immediately before another download is scheduled to begin

� during hours of high network activity 

If you run an unscheduled download at any of these times, it might cause th
download to fail, or it might reduce server performance by using up resourc
40 CallPilot
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Setting up a download schedule

Introduction

Before Reporter can generate reports, OM data must be downloaded from 
CallPilot server to your PC client. When you set up a download schedule, y
ensure that OMs are copied from the server to your client regularly. For mo
information, see “Guidelines for scheduling downloads” on page 38.

Before you begin

Before you can schedule a download for a server, you must log on to a clien
connect to a CallPilot server.
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To log on to a server

1 From the Windows desktop, click Start >Programs > CallPilot 
Administration Client.

2 Double-click the server to which you want to connect in the right panel.

Result: Your PC client connects to the server. During connection, the 
Connection Progress box appears, which tells you about the progress of 
the operation. When connection is complete, the logon dialog box opens. 

3 In the User ID field, type your server user ID. 

4 In the Password field, type your current server password.

Note: If you do not know your user ID or new password, contact your 
system administrator.  

5 Click OK.

Result: The CallPilot Administration Client window appears.
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To schedule a download for the currently connected server

1 Double-click System Administration > System Performance Monitoring > 
Reporter Download Schedule.

Result: The Reporter Download Schedule dialog box appears.

Note: The first time you set up a download schedule for your server, an 
empty database is automatically created on your PC hard disk. Before the 
database is created, Reporter suggests a default directory where the new 
database will be located. If you want to change the location of the default 
directory, you can select a new drive. Once you select a new drive, 
however, you cannot change the location.

2 Make sure the Schedule OM Download from server box is checked. 

3 From the Next Download Date list, select the date of the next download.

Note: All dates and times in this procedure refer to the server. If your PC 
client and server are located in different time zones, confirm the correct 
dates and times before performing the download.

Note: The date of the server’s next download is increased by one day after 
each download.
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4 From the Next Download Time list, select the time of the download.

Result: Reporter Download Schedule downloads OM data once every 24 
hours from the time you specify. For example, if you specify 1:00 a.m., OM 
data downloads once a day at 1:00 a.m.

5 Click Save to return to the CallPilot Administration Client. 
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Checking a server’s next download time

Introduction

Check the download times assigned to each server before performing an 
immediate download. You must prevent the immediate download from 
conflicting with a download that is already running.

You should also check the download times assigned to various servers if yo
scheduling downloads for multiple servers. This ensures that your schedule
downloads do not conflict with one another. 

 Reporter Communicator

Use the Reporter Communicator program to view download schedules for a
servers. Reporter Communicator is a subcomponent of Reporter that contro
network link between the CallPilot server and your PC. Whenever OMs are
downloaded from the server to your PC, Reporter Communicator works wit
Reporter Download Schedule to control the download process. 
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To determine the current system’s next download time

1 Double-click the Reporter Communicator icon on the right side of the 
Windows status bar.

Note: Reporter Communicator starts automatically whenever you start your 
PC client. To save room on your screen, you can minimize the Reporter 
Communicator window and display it as an icon on the Windows status bar.

2 In the Next download time column, check the server’s next download date 
and time.

3 Click Hide to minimize Reporter Communicator.
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Performing an unscheduled download

Introduction

Perform an unscheduled download when you want to

� view the most recent OMs collected by the server

� view OMs collected by a server that does not have a regular download
schedule

� collect OMs if a scheduled download has failed

For more information on unscheduled downloads, see “Understanding 
unscheduled downloads” on page 40.

Getting there  Exploring - CallPilot Administration Client > CallPilot System > System 
Administration > System Performance Monitoring > Reporter Download 
Schedule
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To perform an unscheduled download

1 Click Download Now.

Result: The Download Now...dialog box opens.

2 In the Start Date box, type the first day that OM data is included in the 
download.

Note: All dates and times in this procedure refer to the server. If your server 
is in a different time zone, confirm the correct dates and times before 
performing the download.

3 In the Start Time box, type the time that the first collected OM data begins 
to be included in the download.

4 In the End Date box, type the last day OM data is included in the download.

5 In the End Time box, type the time OM data stops being included in the 
download.

6 Click OK to return to the Reporter Download Schedule.
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To cancel a download 

In the Download in Progress dialog box, click Stop Download.

Note: When you cancel a download that is already in progress, you 
interrupt the transfer of OM data from the server to your client. Use an 
unscheduled download to retrieve these OMs at a later time.
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Section C: Maintaining the client OM 
database

In this section
 Overview of the OM database 52

 Specifying the storage period for OMs in the database 54

 Repairing the OM database 56

 Backing up the OM database 58

 Clearing the OM database 59
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Overview of the OM database

Introduction

The first time you set up a download schedule, an empty database is 
automatically created on your PC client. This database stores all OMs that 
downloaded from the server. If you are downloading OMs from multiple serv
one database is created for each server. Downloaded OMs are stored in th
respective databases.

Database location

The OM database is located in a default directory on drive C of your PC clie
or on a drive that you specify when setting up your initial download schedul
The default directory is C:\Nortel\client\en\data. 

Backing up the database

To prevent valuable data from being lost due to a corrupted database or 
unrecoverable disk crash, back up the OM database regularly. 
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Also back up the following Reporter application databases located under 
Nortel\client\en\data:

� rptsyscust.mdb

� rptsystat.mdb

� rptom.mdb

CallPilot does not provide backup facilities for the PC client. Include the OM
database and the Reporter application databases in your existing backup 
strategy, or use the Backup utility supplied by Windows. For more informati
on this utility, refer to the Windows online Help or user’s guide.
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Specifying the storage period for OMs in the 
database

Introduction

By default, downloaded OMs are stored in the OM database for 35 days. Yo
can specify a storage period of up to 180 days. You can also specify a diffe
storage period for each OM database.

Getting there  Start > Programs > Nortel CallPilot Administration > Exploring - 
CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To specify the storage period

1 Double-click the desired CallPilot Administration Client folder.

Result: One or more CallPilot server names appear.

2 Select the server associated with the OM database.

Note: This is the server that downloads OMs to the database.
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3 From the Customize menu, select Database Settings.

The Database Settings dialog box opens.

4 In the Store... days worth of data in the Reporter box, type the number of 
days you want to store OM data.

5 Click OK to return to the Reporter window.
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Repairing the OM database

Introduction

If you suspect that your OM database is corrupted, you can run the Repair u
The Repair utility attempts to clear the database of corrupted data and resto
previously saved OMs.

Signs of a corrupted OM database

If your database is corrupted, you cannot 

� retrieve data from the database

� read data stored in the database

� generate reports

Check the Reporter Communicator log window and the PC event log for 
additional information.

Getting there  Exploring - CallPilot Administration Client > Utilities > Reports > Nortel 
Reporter window

To repair the OM database

1 Double-click the desired CallPilot Administration Client folder.

Result: One or more CallPilot servers appear.

2 Select the server associated with the corrupted database.

Note: This is the server that downloads OMs to the corrupted database. 
For example, if the OM database that belongs to server X is corrupted, you 
must select server X from the tree view. 
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3 From the Customize menu, select Database Settings.

Result: The Database Settings dialog box opens. 

4 Click Repair Database.

5 Click OK to return to the Reporter window.
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Backing up the OM database

Introduction

To prevent OM data from being lost due to a system failure, back up your O
database regularly. 

Also back up the Reporter application databases. The following Reporter 
application databases are located under Nortel\client\en\data:

� rptsyscust.mdb

� rptsystat.mdb

� rptom.mdb

To back up the OM database

1 Click Start on your Windows taskbar. 

2 Click Programs > Accessories > System Tools, and select Backup.

3 Refer to the Windows Help topics for more information on the Backup utility.
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Clearing the OM database

Introduction

If you suspect that your OM database is corrupted and the Repair utility can
fix it, remove all existing OMs from the database. After clearing the databas
use a backup tape to reload the most recently backed-up OMs into the emp
database. 

Note: Customized reports and alerts are not affected by the Clear function.

Getting there  Exploring - CallPilot Administration Client > Utilities > Reports > Nortel 
Reporter window

To clear the OM database

1 Select the server associated with the corrupted database.

Note: This is the server that downloads OMs to the corrupted database. 
For example, if the OM database belonging to server X is corrupted, you 
must select server X from the tree view.

ATTENTION! Clear the database only if the Repair utility fails to 
correct the problem. Once you clear the database, you
cannot recover any of the OMs.
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2 From the Customize menu, select Database Settings.

Result: The Database Settings dialog box opens.

3 Click Clear Database.

Result: A confirmation dialog box appears.

4 Click Yes.

5 Click OK to close the Database Setting dialog box and return to the 
Reporter window.
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Using reports

In this chapter
Section A: About reports 63

Section B: Accessing Nortel Reporter 77

Section C: Generating reports 85

Section D: Customizing the data displayed in reports 101

Section E: Printing and exporting reports 111
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Overview of reports

Introduction

Reports organize the operational measurements collected by your server in
format that you can study and analyze. When you study reports over a peri
time, you can identify trends and patterns related to system usage. With thi
information, you can improve the overall efficiency of your system, increase
system security, and troubleshoot potential problems.

How reports are generated

To generate reports, ensure that OMs are downloaded regularly from each 
your CallPilot servers to your PC client. Reports display the OMs in an easy
read format.
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Example
The Channel Usage Report screens downloaded OMs for information relate
DSP channels. The report extracts any relevant information and organizes 
according to the number of ingoing calls and the number of outgoing calls.

What can I do with reports?

When you use Nortel Reporter, you can customize, print, and export the 
information contained in reports.

Customize reports
The information contained in a report can be customized so that only releva
data appears. For example, you can filter the data in a report to show activi
that occur in a particular department. For more information, see Section D: 
“Customizing the data displayed in reports,” on page 101.
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Print reports
You can print reports on a regular basis according to a preset print schedul
you can print them on demand. When you set up a print schedule, you can
the results of your reports over a period of time. This can help you to identif
patterns and trends related to system usage. For more information, see Section 
E: “Printing and exporting reports,” on page 111.

Export reports
You can export information in a report to a variety of file formats. These file 
formats can be useful if you want to view the report on the World Wide Web
over an organizational intranet, or in a spreadsheet program. For more 
information, see Section E: “Printing and exporting reports,” on page 111.
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Benefits of reports

Introduction

Analyze the information in reports to help you

� establish a pattern of normal behavior

� monitor system usage

� assess your system’s overall efficiency

� detect potential system problems

� monitor system security

� bill users for service usage

� monitor administrative changes

Use reports to establish a baseline

Generate reports on a regular basis to establish a pattern of normal behavi
“baseline” for your system. This baseline lets you differentiate between norm
system activities and unusual or suspicious activities. Once you have establ
a baseline, you can use reports to identify potential problems.

Example
Channel Usage Reports from the last three months show that each of your 
channels processes an average of 50 calls an hour. If one channel suddenly
to only three or four calls an hour, this might indicate a problem with your 
system’s hardware or configuration. 

Use reports to monitor system usage and assess system efficiency

Study your reports to help you assess the overall efficiency of your system 
decide whether changes are necessary. Among other things, reports can sh

� how long callers wait before their calls are handled

� how many callers abandon their calls

� how often callers access each service or feature
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� how many calls are processed by each channel

� how much free disk space is available

Example
The Service Summary Report shows the type of service accessed by caller
the number of times each service was accessed. Analyze this report to give
an overall sense of which services generate the most traffic and which serv
generate little or no traffic.

Use reports to detect potential system problems

Analyze the information in reports to help you identify potential system 
problems, such as hardware failures or inadequate resources. Some poten
problems that can be detected through reports are discussed in the followin
examples.

Example 1: Hardware failure
If the Channel Usage Report shows that channel 4 did not handle any calls
during an eight-hour period, check that this channel has been configured 
properly. Also ensure that the component has not malfunctioned.

Example 2: Inadequate resources
If the Service Quality Summary Report indicates that callers are experienci
lengthy wait time before they access a channel, there might not be enough 
channels to handle the volume of traffic. Increase the number of channels o
system if the volume of traffic is higher than was originally anticipated.

Example 3: Inefficient usage
If the Fax Deliveries Activity Report shows that callers are not accessing the
feature, this might indicate that

� callers do not know how to use the service. If so, you must word the 
service’s prompts more clearly.

� callers are not aware that the service exists. Look for ways to promote 
service to potential callers.

� technical problems are occurring. Investigate further and have the prob
repaired.
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Use reports to monitor system security

If you are concerned about the security of your system, reports can help yo
detect potential hacker activity.

Example
If the Voice Messaging Activity Report indicates a discrepancy between the
number of call answer sessions and the number of generated messages, th
might indicate hacker activity. If hackers thru-dial out of your system during
call answer session, sessions are recorded in your report but no messages
recorded.

Use reports to bill service usage
Reports can also help to simplify your billing process. Bill-back reports moni
how often users access services that have a fee associated with them (for 
example, long distance).

Example
The DTT Usage Report tracks calls made by the DTT service to external 
numbers. This report records information such as 

� the name and department of the user who placed the call

� the date and time of the call

� the number to which the call was placed 

� the duration of the call

If some of the calls listed in this report were placed to long-distance numbe
you can determine which user or department to bill.

Use reports to track changes made by administrators

The Administration Action Report tracks changes made by administrators. T
information is important because it provides a history of changes, such as w
changes were made, where they were made, and who made the changes.
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Guidelines for interpreting reports

Introduction

When you interpret reports, consider the following guidelines.

System size

Know your system’s disk capacity and the number of channels that have be
installed. This helps you to realize when you are reaching resource limitatio
and to plan for future upgrades.

Establish a baseline

Know what is normal or average behavior for your system. Establish a base
to help you differentiate between normal system activities and unusual or 
suspicious activities.

Consider external factors

If your reports show unusual system activities, consider external events. Fo
example, an extremely low volume of traffic for a Monday afternoon can be
result of a national holiday.

How your organization uses the system

Know how your organization operates on a day-to-day basis. The informatio
contained in reports often relates directly to your company’s routines and 
schedules. For example, if a large number of employees are working overti
your reports might indicate a high percentage of after-hours logons. If you d
not know how the organization functions, find someone who can help to 
interpret your report.
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Consult users

Consult the users of the system for further insight into your reports. Find ou
the system is working for the users and if they have any problems to report
Some system problems result from improper use of the system (perhaps du
lack of end-user training).

Consider new features or services

Consider how long a feature or service has been in operation. If users are cu
about a new feature, it might generate more traffic than usual. If users are n
familiar with the feature, it might generate less traffic. 
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Types of reports

Introduction 

Reports are grouped into categories according to the type of information th
display. 

System status reports

System status reports show trends and patterns related to system usage. F
example, the Service Quality Summary Report shows the number of calls 
processed by voice, fax, and speech-activated messaging channels. System
status reports include

� Service Quality Summary Report

� Service Quality Detail Report

� Channel Usage Report

� Multimedia File System Usage Report

� Disk Usage Report

For detailed information about each report, see Chapter 5, “System status 
reports.”

Messaging reports

Messaging reports show trends and patterns related to the messaging prog
installed on your CallPilot system. For example, the Inactive User Report sh
which users are not using their mailboxes. The Top Users of Storage Repo
shows which users are using excessive amounts of voice storage. Messagi
reports include

� Call Answering/User Responsiveness Report

� Desktop Messaging Activity Report

� Inactive User Report

� Mailbox Counts Report

� Mailbox Call Session Summary Report
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� Voice Messaging Activity Report

� Fax Messaging Activity Report

� Messaging Usage Report

� Speech Activated Messaging Analysis Report

� Top Users of Storage Report

� Users Exceeding Storage Limit Report

For detailed information about each report, see Chapter 8, “Messaging repo

Outcalling reports

Outcalling reports show trends and usage patterns related to outcalling acti
For example, the Fax Print Audit Trail Summary Report shows faxes that ha
failed to print. The Fax on Demand Audit Trail Detail Report shows faxes th
failed to transmit. Outcalling reports include

� Fax Deliveries Activity Report

� Fax on Demand Audit Trail Detail Report

� Fax on Demand Audit Trail Summary Report

� Fax Print Audit Trail Detail Report

� Fax Print Audit Trail Summary Report

� RN Activity Report

� RN Audit Trail Detail Report

� RN Audit Trail Summary Report

� DTT Activity Report

� DTT Audit Trail Detail Report

� DTT Audit Trail Summary Report

For detailed information about each report, see Chapter 10, “Outcalling repo
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Multimedia application report

The multimedia application report analyzes service activity for voice menus
announcements, and fax on demand. The multimedia application reports inc
the Building Block Summary Report. 

For detailed information about this report, see Chapter 9, “Multimedia repor

Networking reports

Networking reports show trends and patterns related to networking activity.
Networking reports include

� Networking Activity Report

� Open Networking Activity Report

For detailed information about each report, see Chapter 11, “Networking 
reports.”

Traffic reports

Traffic reports show how much the system is being used. For example, the 
Productivity Report shows the total number of ingoing and outgoing calls 
processed by the CallPilot system. The System Traffic Summary Report sh
the number of times each service is accessed. Traffic reports include 

� Productivity Report

� System Traffic Summary Report

For detailed information about each report, see Chapter 7, “Traffic reports.”

Bill-back reports

Bill-back reports monitor how often users access services that have a fee 
associated with them (such as long distance). Typically, the information 
contained in bill-back reports is exported to an external billing program. Thi
allows administrators to charge the appropriate user or department for serv
usage. Bill-back reports include

� 800 Access Bill-back Report
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� DTT Usage Bill-back Report

� Messaging Usage Bill-back Report

� Network Usage Bill-back Report

� RN Usage Bill-back Report

� Fax on Demand Bill-back Report

� Fax Print Bill-back Report

For detailed information about each report, see Chapter 12, “Bill-back repo

Administration reports

Administration Action reports provide information about changes performed
administrators. They also give brief explanations of actions and the items 
affected by these actions.

For detailed information about the Administration Action report, see Chapte
“Administration reports.”
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Section B: Accessing Nortel Reporter

In this section
 Running Nortel Reporter 78

 Changing your password 79

 Resetting the Nortel Reporter password 82
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Running Nortel Reporter

Introduction

Run Nortel Reporter when you want to customize, print, or export reports. 

To run Nortel Reporter

1 From your Windows Desktop, click Start. 

2 Select Programs > CallPilot Administration Client > Utilities > Reports. 

Result: The Reports Login dialog box appears.

3 In the Password box, type your password.

Note: If you are logging on to Reporter for the first time, you must type the 
default password provided by Nortel Networks: password . If you are not 
logging on for the first time, type your chosen password.

4 Click OK to open the Reporter window. 
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Changing your password

Introduction

Change your Nortel Reporter password to ensure that only authorized users
access to this program. 

Change the default password

The first time you access Nortel Reporter, type the default password supplie
Nortel Networks: password. The system prompts you to change the default 
password after logging on to Reporter for the first time. 

Change your password regularly

To ensure security, change your password every 30 days.

Choose a secure password

Poorly chosen passwords can leave your organization open to hacking. Wh
choosing your new password, make sure you follow these rules:

� Never use words that are in a dictionary. Combinations of letters and 
numbers are harder to guess.

� Never use your name or other personal information, such as your birth 
or phone number.

� Never use family names or other words that can be associated with you
example, if you are a bird-watcher, “falcons” is a bad choice for a 
password.

� Never let anyone borrow your password.

� Never write down your password.

� Never reuse old passwords.

� Use at least six characters in your password.
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Getting there  Exploring - CallPilot Administration Client > Utilities > Reports 

To change the default password (first login)

1 In the Password box, type the default password: password . 

2 Click OK.

Result: The Change Initial Reports Password dialog box appears.

3 In the Change Initial Reports Password dialog box, click Change Now.

Note: The Change Now button appears only the first time you log on to 
Reporter.

4 In the Change Reports Password dialog box, click in the Old Password box 
and type the password you used in step 1.

5 In the New Password box, type your new password. 

Note: Your password must be between 6 and 30 characters long. Only 
alphanumeric characters are valid. Passwords are case-sensitive.

6 In the Confirm new password box, type your new password.

7 Click OK.
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To change your password regularly

1 In the Nortel Reporter window, on the File menu, click Change Password.

Result: The Change Reports Password dialog box appears.

2 In the Old Password box, type your current password.

3 In the New Password box, type your new password.

Note: Your password must be between 6 and 30 characters long. 
Passwords are case-sensitive.

4 In the Confirm new password box, type your new password.
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Resetting the Nortel Reporter password

Introduction 

Reset the Nortel Reporter password to its default if you forget your passwo
Only the system administrator can reset the password.

Before you begin

Before you can reset the Nortel Reporter password, you must log on to a se
The server you log on to must have Reporter Download Scheduler installed

To log on to a server

1 From the Windows desktop, click Start > Programs > CallPilot 
Administration Client.

2 Double-click the server to which you want to connect in the right panel.

Result: Your PC client connects to the server. During connection, you see 
the Connection Progress box, which tells you about the progress of the 
operation. When connection is complete, the Login dialog box opens. 

3 In the User ID field, type sysadmin . 

4 In the Password field, type your current server password.

Note: If you do not know your user ID or new password, contact your 
system administrator. 

5 Click OK.

Result: The CallPilot Administration Client window appears.
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Getting there  CallPilot Administration Client > CallPilot system

To reset the Nortel Reporter password

1 From the CallPilot Administration Client window, double-click System 
Administration > System Performance Monitoring > Reporter Download 
Schedule.

Result: The Reporter Download Schedule dialog box appears.

2 Click the PC icon located in the upper far-left corner to display the menu.

3 Select Reset Password.

Result: The Nortel Reporter password is reset to password, which is the 
default password for Reporter.

4 Select Save.

Note: The next time you log on to Reporter, the system prompts you to 
change the password.
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Section C: Generating reports

In this section
 Overview of generating reports 86

 Adding reports to the Nortel Reporter window 89

 Removing reports from the Nortel Reporter window 91

 Duplicating a report 93

 Running a report 95

 Changing the traffic units for a report 98
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Overview of generating reports

Introduction

To generate reports, you must ensure that Operational Measurements (OM
downloaded regularly from each of your Nortel Networks servers to your PC
client. Once OM data has been downloaded from a particular server, Norte
Reporter can organize the data into reports. 

Note: If you have not downloaded OM data from your server, see Section B
“Downloading OMs,” on page 35. 

Reports and changes to server time

Changes to the server time affect the accuracy of reports. Any time a repor
generated that includes a date on which the server time was changed, the 
generated for that time can be inaccurate.

The server time can change for various reasons:

� Daylight Savings Time

� server battery change

� server resynchronized with switch time

If the server time has been advanced by one hour, the generated data of ca
made during that time shows time lengths increased by one hour. Totals an
averages of call sessions displayed in reports covering the time change are
increased.

Example
Server time is advanced by one hour due to Daylight Savings Time. Calls in
progress when the time was changed are increased by one hour.

Actual call length: 5 minutesReport data shows: 1 hour 5 minutes

If the server time has been decreased by one hour, the generated data of c
made during that time can show negative time lengths. Totals and averages
call sessions displayed in reports covering the time change are also decrea
86 CallPilot



April 2000 Using reports 

n 

 
age 
use 

 
rter 

el 
 the 
Example
Server time is decreased by one hour due to Daylight Savings Time. Calls i
progress when the time was changed are decreased by one hour.

Actual call length: 5 minutes Report data shows: -55 minutes

Reports and multiple servers

If you have more than one server in your organization, you must generate 
different reports for each server. For example, if you suspect that there is a
problem with one of the channels on Server X, you can run the Channel Us
Report. If you want to see how Server Y is handling fax deliveries, you can 
the Fax Deliveries Activity Report.

Organizing reports for multiple servers

If your organization has many servers, it can be difficult to keep track of the
reports that are generated for each server. The tree view in the Nortel Repo
window organizes reports on a per-server basis. 

Use the tree view to navigate to a server and double-click its icon. The Nort
Reporter window displays a list of all the reports that are currently in use for
selected server.
Reporter Guide 87



Using reports  Standard 1.0

hat 
 
u no 
The Nortel Reporter window

The Nortel Reporter window acts as a palette where you can store reports t
are currently “in use” for each of your servers. All of the reports listed in this
window can be printed, exported, or customized. You can remove reports yo
longer require. A permanent copy of each report is kept in the New Report 
dialog box so that you can add it to the Reporter window when necessary. 
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Adding reports to the Nortel Reporter window

Introduction

You must add reports to the Nortel Reporter window before you can work w
them. To help you get started, the Nortel Reporter window contains ten rep
that are used on a regular basis. If you require additional reports, add them 
Reporter window.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > CallPilot 
Administration Client > CallPilot system > Reporter window
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To add reports to the Nortel Reporter window

1 On the File menu, click New.

Result: The New report or alert dialog box opens.

2 Make sure Report is selected.

3 Click the appropriate tab for the type of report you want to add.

4 Click the report you want to add to the Nortel Reporter window.

5 Click OK.

6 In the Report Name box, type a name for the report or accept the default.

7 In the Comments box, type any additional information about the report.

8 Click OK to return to the Nortel Reporter window.

Result: The selected report is added to the Nortel Reporter window. You 
can now run, print, or customize the selected report.
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Removing reports from the Nortel Reporter 
window

Introduction

If you seldom use a report, you can remove it from the Reporter window. Th
ensures that your display does not become cluttered with unused reports. 

Example
During the last two months, you have used the Fax Delivery Report to moni
fax transmission errors. However, the fax problem has now been solved and
no longer need this report. To prevent the report from taking up valuable spa
the Nortel Reporter window, you remove it.

What happens when you remove a report

When you remove a report, you delete the report’s icon from the Nortel Repo
window and cancel the report’s print schedule. However, a permanent copy
the original report remains in the New Report dialog box. This means that y
can add the report to the Nortel Reporter window in the future. 

Note: Duplicated reports are deleted permanently from the Nortel Reporter 
program.

Before you begin

Use the tree view located on the left side of the Nortel Reporter window to se
the appropriate server. For more information, see “Organizing reports for 
multiple servers” on page 87.
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Getting there  Exploring - CallPilot Administration Client > Utilities > Reports > Nortel 
Reporter window

To remove a report

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to remove.

5 Click the report you want to remove.

6 From the File menu, click Delete.

Result: A confirmation dialog box appears.

7 Click Yes to confirm the deletion and to return to the Nortel Reporter 
window.

See also

For more details, refer to “The Nortel Reporter window” on page 88.
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Duplicating a report

Introduction

If you want to create a report quickly and easily, you can duplicate an existi
report and customize it to suit your needs. For more information on customi
reports, see Section D: “Customizing the data displayed in reports,” on page 
101.

Example
The Inactive Users Report shows which users are not responding to their vo
mail. If you want to monitor inactive users on a per-department basis, make
several copies of the report. Use the Filtering feature to customize each cop
show only inactive users from one department. For example, the Inactive U
Accounting Report shows users in the accounting department who are not u
their voice mail. The Inactive Users/Human Resources Report shows users 
human resources department who are not using their voice mail.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To create a report from an existing report

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to duplicate.

5 Click the report on which you want to base the new report.
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6 On the File menu, click Duplicate.

Result: A copy of the report is added to the Reporter window. Reporter 
automatically assigns a number to the copy (for example, Channel Usage 
Report [2]).

7 Click OK to return to the Reporter window.
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Running a report

Introduction

If you want to see what a report looks like when it is printed, you can view t
report on the screen.

Before viewing a report on-screen, you must specify the number of days of
downloaded OM data that you want the report to contain. For example, you
set the report to display three days of downloaded OM data, from Monday a
12:00 a.m. to Wednesday at 12:00 a.m.

Tips

Here are some useful tips for viewing reports:

� To increase or decrease the size of the report, click the size percentage
at the top of the screen.

� To scroll through the pages one at a time, use the left and right arrow 
buttons.

� To print the report, click the printer icon. For more information on printin
reports, see Section E: “Printing and exporting reports,” on page 111.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.
Reporter Guide 95



Using reports  Standard 1.0
Getting there  Exploring - CallPilot Administration Client > Utilities > Reports > Nortel 
Reporter window

To run a report

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to run.

5 Click the report that you want to run.

6 On the File menu, click Run Report.

Result: The Reporting Interval dialog box opens.

7 In the Start Date box, type the first day that OM data is included in the 
report (for example, Mon 07 / 06 / 98). 

8 In the Start Time box, type the time that OM data begins to be included in 
the report (for example, 12: 00 AM). 

9 In the End Date box, type the last day that OM data is included in the report 
(for example, Wed 07 / 08 / 98). 
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10 In the End Time box, type the time that OM data stops being included in the 
report (for example, 12: 00 AM).

11 Click OK.

Result: The selected report appears on the screen. In the above examples, 
it includes three days’ worth of OM data from Monday at 12:00 a.m. to 
Wednesday at 12:00 a.m.
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Changing the traffic units for a report

Introduction

Data from the Channel Usage Report and the System Traffic Summary Rep
can be shown in centa-call seconds (CCS) or Erlangs.

Erlang 

An erlang is an international unit of the average traffic intensity (occupancy) 
facility during a period of time, normally a busy hour. The number of erlangs
the ratio of the time during which a facility is occupied (collectively or 
cumulatively) to the time this facility is available for occupancy. 

Note: 1 Erlang = 36 CCS

CCS 

CCS (centa call seconds) is the American unit of telephone traffic.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.
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Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To change the traffic units for a report

1 Select a server from the Nortel Reporter window.

2 On the Customize menu, select Traffic Units.

Result: The Traffic Units dialog box opens.

3 To display information in centa call seconds, make sure CCS is selected.

4 To display information in Erlangs, make sure Erlangs is selected.

5 Click OK to return to the Nortel Reporter window.
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Section D: Customizing the data 
displayed in reports 

In this section
 Overview of customizing reports 102

 Sorting the data in a report 104

 Adding comments to a report 106

 Filtering data in a report 108
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Overview of customizing reports

Introduction

When you customize a report, you eliminate excessive data and organize th
remaining information into an easy-to-read format. Well-organized reports 
improve the speed and accuracy with which you interpret data.

Note: You can customize only the data contained in a report. The fields in a
report are predefined and cannot be changed.

How reports can be customized

There are three ways to customize a report:

� sorting 

� adding comments 

� filtering

Sorting

This method organizes the data in a report so that relevant information is 
grouped together. This makes it easier to analyze and interpret information

Adding comments

This method lets you specify additional information about the data. 

Filtering

This method reduces the volume of data displayed in a report. Before you c
filter data, you must define your selection criteria. There are three types of 
selection criteria—item, operator, and value.

Use the Selection Criteria tab to reduce the volume of data displayed in the
selected report.
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Item
The item is the main criterion that Reporter uses to filter data. Each report h
own items, which are displayed in the Item list box. For example, the items 
listed in the Top Users of Storage Report are Name, Mailbox Class, Switch
location, and Department.

Operator
The operator is a mathematical function that compares the item with the va
Seven possible operators can be used to define your criteria:

� equal to

� not equal to

� greater than

� less than

� greater than or equal to

� less than or equal to

� like

Value
The value specifies a range for the criterion chosen from the Item list. The 
information entered in this box depends on the item you select. For exampl
you select Name as the item, the value must be a user’s name. If you selec
Department, the value must be the department’s name.

Filtering example

The Top Users of Storage Report helps you determine which users are usin
most voice storage. To reduce the scope of the data displayed in this repor
select Department as the item, is equal to as the operator, and Accounting 
value. Together these selection criteria produce a report that shows only th
users of storage in the accounting department.
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Sorting the data in a report

Introduction

Sort the data in a report to ensure that relevant information is grouped toge
This makes it easier to analyze and interpret information. 

Example
The Inactive User Report shows all users who are not accessing their mailb
Use the sorting feature to group users by mailbox instead of name.

Limitations

Some reports cannot be sorted. If the Sorting tab does not appear in the 
Properties dialog box, you cannot sort the report.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To sort the data contained in a report

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Double-click the Reports folder.

4 Select the folder that contains the report you want to sort.

5 Click the report that you want to sort.
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6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the Sorting tab.

8 From the Sort by list, select the criterion you want to use as a sorting 
parameter.

Note: By default, data is sorted in ascending order. To reverse the order of 
the data, make sure Descending is selected.

9 To choose additional sorting parameters, repeat step 4.

10 Click OK to return to the Reporter window.
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Adding comments to a report

Introduction

When you add comments to the data in a report, you ensure that additional
information is not forgotten or overlooked.

Limitations

Comments are visible only on the screen. They do not appear when the rep
printed.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window
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To add comments to a report

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to add comments to.

5 Click the report to which you want to add comments.

6 From the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the General tab.

8 In the Comments box, type the additional information about the report.

9 Click OK to return to the Reporter window.
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Filtering data in a report

Introduction

When you filter data, you limit the scope of the data in a selected report. Fo
example, if you set the selection criteria for the Messaging Usage Bill-back
Report to include a particular department, the resulting report contains only 
for that department.

Narrowing the filter’s scope

If you want to further reduce the volume of information in a report, select Al
conditions. This ensures that the information in the report meets all of the 
criteria you have specified.

Widening the filter’s scope

If you want to increase the volume of information in a report, select At least 
condition. This ensures that the information in the report meets at least one
the criteria you have specified.

Before you begin

Use the tree view located on the left side of the Nortel Reporter window to se
the appropriate server. For more information, see “Organizing reports for 
multiple servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window
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To filter a report’s data

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to filter.

5 Click the report that you want to filter.

6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the Selection Criteria tab.

8 From the Item list, select an appropriate item.

Note: Some reports cannot be filtered. If the Item list does not specify any 
selection criteria, you cannot filter the report.
Reporter Guide 109



Using reports  Standard 1.0
9 From the Operator list, select an appropriate operator.

10 From the Value list, select an appropriate value.

11 Click OK to return to the Reporter window.

To narrow the scope of the filter

1 Make sure that All Conditions is selected.

2 From the Item list, select an appropriate item.

3 From the Operator list, select an appropriate operator.

4 From the Value list, select an appropriate value.

5 Repeat steps 2 to 4 to set up to three additional filters.

6 Click OK to return to the Reporter window.

To widen the scope of the filter

1 Make sure At least one Condition is selected.

2 From the Item list, select an appropriate item.

3 From the Operator list, select an appropriate operator.

4 From the Value list, select an appropriate value.

5 Repeat steps 2 to 4 to set up to three additional filters.

6 Click OK to return to the Reporter window.
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Section E: Printing and exporting 
reports

In this section
 Overview of printing reports 112

 Overview of exporting reports 114

 Setting a report’s print schedule 116

 Printing a report on demand 118

 Printing a report as a graph 120

 Printing a list of reports 123

 Scheduling a report to export 124
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Overview of printing reports

Introduction

When you print reports over a period of time, you can identify significant 
patterns and trends related to system usage. 

Example
You have scheduled the Inactive User Report to print out once a day for thr
months. At the end of the first month, you analyze the reports and notice th
three users have never logged on to their mailboxes. You might want to ens
that these users are properly trained to use the voice mail system.

Print schedule

You can print reports on a regular basis according to a preset print schedul
you can print reports on demand. Set up a print schedule so you can view t
results of your reports over a period of time. This helps you to identify patte
and trends related to system usage.

Graph format

Most of the reports generated by Reporter are printed in a standard table fo
However, you can print some reports as graphs. Graphs let you analyze da
quickly, observe trends, and make comparisons about system usage. 

Example
The System Traffic Summary Report lets you monitor the total amount of tra
processed by the different services installed on your system. Print this repor
graph to make it easy to identify the system’s busiest hours and to determin
whether you have sufficient channel capacity to handle the volume of traffic

Reports that can print as graphs

The following reports can print as graphs:

� Building Block Summary Report
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� Networking Activity Report

� Fax Deliveries Summary Report

� Channel Usage Report

� Multimedia File System Usage Report

� Disk Usage Report

� System Traffic Summary Report

Store printed reports

Print out and store reports to identify and compare trends over a period of t
If you discard reports too soon, significant problems can go unnoticed.
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Overview of exporting reports

Introduction

When you export a report, you change its current file format to the file forma
an external program. Use exporting if you want to view the report on the Wo
Wide Web, over an organizational intranet, or in a spreadsheet program. Exp
bill-back report to an external billing program to charge users or department
service usage.

File formats

The file formats to which reports can be exported include the following: 

File format File extension Version

Comma-separated 
values

.csv n/a

Crystal Reports .rpt n/a

Data Exchange Format .dif n/a

Excel .xls 2.1

3.0

4.0

5.0

Lotus 1-2-3 .wk1

.wk2

.wk3

1.0

2.0

3.0

Record style (columns 
of values)

.rec n/a

Rich Text Format .rtf n/a

Tab-separated text .ttx n/a
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Limitations

When you export a report, some or all of the formatting might be lost or 
modified.

Tab-separated values .tsv n/a

Text .txt n/a

Word for Windows .doc n/a

File format File extension Version
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Setting a report’s print schedule

Introduction

When you set up a print schedule, you can print reports on a daily, weekly, 
monthly basis. You can also schedule reports to print immediately after an O
download. Print reports on a regular basis to help you identify patterns and 
trends related to system usage.

All reports print to the default printer specified in the Windows Control Pane

Store printed reports

Store printed reports so that you can identify and compare trends over a pe
of time. If you discard reports too soon, significant problems can go unnotic

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To set a report’s print schedule

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report for which you want to set the print 
schedule.

5 Click the report for which you want to set a print schedule.
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6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the Print Schedule tab.

8 Make sure the Print report on an ... basis box is checked.

9 From the Print report on an list, select how often you want the report to print 
(for example, weekly basis).

Result: The Include ... day(s) worth of data in report box shows the number 
of days of data included in the report. For example, if you set the report to 
print weekly, seven days of data are automatically included in the report. 

10 In the Next print will occur on box, type or select the date on which you want 
the report to print.

Note: Reports set to print monthly print on the first day of the month.

11 In the at box, type the time at which you want the report to print.

Note: Make sure the print time is after the scheduled download time. For 
example, if your server downloads Monday at 1:00 a.m., schedule your 
report to print after the download has completed.

12 If you specified unscheduled printing in step 5, you must specify in the 
Include ... day(s) worth of data in report box the number of days’ worth of 
data that you want to include in the report. 

13 Click OK to return to the Reporter window.
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Printing a report on demand

Introduction

Print a report on demand when you do not want to wait for the print schedu
execute. You can also print a report on demand if you suspect that there is 
problem with your system and you require data ahead of the print schedule

All reports print to the default printer specified in the Windows Control Pane

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To print a report on demand

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to print.

5 Click the report you want to print.
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6 On the File menu, click Print Report.

Result: The Reporting Interval dialog box opens.

7 In the Start Date box, type the start date for data printed in the report.

8 In the Start Time box, type the start time for data printed in the report.

9 In the End Date box, type the end date for data printed in the report.

10 In the End Time box, type the end time for data printed in the report. 

11 Click OK.
Reporter Guide 119



Using reports  Standard 1.0

ou 
erve 

l. 
Printing a report as a graph

Introduction

Most of the reports generated by Reporter are printed as tables. However, y
can print some reports as graphs. Graphs let you analyze data quickly, obs
trends, and make comparisons about system usage. 

All reports print to the default printer specified in the Windows Control Pane

Reports that can be printed as graphs

The following reports can be printed as graphs:

� Building Block Summary Report

� Networking Activity Report

� Fax Deliveries Activity Report

� Channel Usage Report

� Multimedia File System Usage Report

� Disk Usage Report

� System Traffic Summary Report
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Sample graph 

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window
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To print a report as a graph

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3  Double-click the Reports folder.

4 Select the folder that contains the report you want to print as a graph.

5 Click the report you want to print as a graph.

6 On the File menu, click Properties.

Result: The Properties dialog box appears.

7 Click the Output Options tab.

8 Make sure Print report on default printer is selected.

9 Make sure Graph is checked.

10 Click OK to return to the Reporter window.
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Printing a list of reports

Introduction

If you want to keep a list of reports for future reference, print the contents of
Reporter window. This also helps you to keep track of the print schedules 
assigned to each report.

All reports print to the default printer specified in the Windows Control Pane

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To print a list of reports

1 Double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Click a Reports folder.

Result: The right pane of the Nortel Reporter window shows a list of 
reports stored in that folder.

4 On the File menu, click Print List.
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Scheduling a report to export

Introduction

Export a report if you want to view the data in an external program, such as
spreadsheet or a company web site. The export feature is especially useful
you need to transfer data from bill-back reports to an external billing progra

Limitations

You cannot export a report that is on a print schedule. Cancel the report’s p
schedule, or duplicate the report and export the copy. For more information
“Duplicating a report” on page 93.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing reports for multiple 
servers” on page 87.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window
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To export a report to an external program

1 Click the report that you want to export.

2 On the File menu, click Properties.

Result: The Properties dialog box opens.

3 Click the Output Options tab.

4 Make sure Export report to the following format is selected.

5 From the Export report to the following format list, select the file format 
used by the external program.
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6 Click Save As.

Result: The Save As window opens.

7 Select the directory in which you want the exported file to be stored.

8 Click OK to return to the Reporter window.
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Section A: About alerts

In this section
 Overview of alerts 130

 Benefits of alerts 133
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Overview of alerts

Introduction

Alerts are special reports that warn users of potential problems with the ser
hardware, software, or security. 

Reports and alerts

Like reports, alerts organize data downloaded from your server into a format
you can study and analyze. Unlike reports, however, alerts are automaticall
triggered once a predefined threshold is exceeded.
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Alert thresholds

When you execute an OM download, each alert compares the data copied 
the server to a predefined number or “threshold.” Whenever the threshold v
is exceeded, the alert is triggered. For example, if the threshold value for th
Excessive After-Hours Logons Alert is set to 25, the alert is triggered when 2
more after-hour logons occur.

Limitations with downloads
Since the Reporter application resides on your PC client, alerts cannot be 
generated until after an OM download takes place. This means that the alert
receive are not generated in real time, as they occur. For example, if your 
Excessive After-Hours Logons Alert threshold is reached at 3:00 p.m. and y
OM download is not scheduled until 5:00 a.m., you do not receive an alert u
after the download has finished.

Signs that an alert has been triggered

Two warning signals indicate a triggered alert:

� If Communicator is minimized, its icon on the Windows taskbar flashes
Communicator is not minimized, an entry is made in the log window.

� An exclamation mark (!) appears next to the alert icon in the Nortel 
Reporter window.

Clear alerts

Clearing an alert removes the warning icons from the Nortel Reporter windo
and stops the Communicator icon from flashing. If you do not clear the alert
warning signals remain.

Print alerts

You can print alerts on a regular basis according to a preset print schedule,
you can print reports on demand. Set up a print schedule to view the results
your alerts over a period of time. This can help you to identify patterns and 
trends related to system usage and security. For more information, see Section 
D: “Printing and exporting alerts,” on page 157.
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Export alerts

You can export the information contained in alerts to a variety of file formats
This is useful if you want to view the information on the World Wide Web, in 
organizational intranet, or in a spreadsheet program. For more information,
Section D: “Printing and exporting alerts,” on page 157.
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Benefits of alerts

Introduction

Analyze the information in an alert to help ensure that your system is opera
correctly and that it is secure.

Use alerts to identify security problems

The following alerts are triggered by possible hacker activity: 

Excessive Failed Logons Alert
This alert is triggered by an unusually high number of unsuccessful logon 
attempts. Incorrect logons can occur if a hacker is running an automated 
program to “crack” mailbox passwords. For more information, see Chapter 
“Alerts.”

Excessive After-Hours Logons Alert
This alert is triggered by an unusually high number of after-hours logons. 
Excessive logons during nonbusiness hours can occur if a hacker has pene
a mailbox. For more information, see Chapter 13, “Alerts.”

Excessive Thru-Dialer Access Alert
This alert is triggered by an unusually high number of thru-dialer accesses.
can occur if a hacker has penetrated your system and is using a thru-dialer
make toll calls. For more information, see Chapter 13, “Alerts.”

Excessive Incomplete Messaging Access Alert
This alert is triggered by excessive failed logons due to invalid passwords b
entered. This can occur if hackers are dialing in to your messaging system 
repeatedly entering different mailbox numbers and passwords. For more 
information, see Chapter 13, “Alerts.”

Use alerts to identify software problems

The following alerts are triggered by potential software problems:
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Failed DTT Alert
This alert is triggered when Delivery-to-Telephone messages are not receiv
This can occur if there is a problem with the DTT service setup. For more 
information, see Chapter 13, “Alerts.”

Failed RN Alert
This alert is triggered when remote notification attempts are not responded
promptly. A high number of failed RN sessions can indicate a problem with 
RN service setup. For more information, see Chapter 13, “Alerts.”

RN Target Problem Alert
This alert is triggered by a high number of outcalling failures to a particular 
remote notification target phone number. This alert can indicate an invalid R
target, a paging service outage, or an RN setup problem. For more informa
see Chapter 13, “Alerts.”

Failed Network Sessions Alert
This alert is triggered by an unusually high number of failed network sessio
This alert can help you determine whether your server is experiencing hard
or setup problems, or insufficient capacity on either the local or the remote 
For more information, see Chapter 13, “Alerts.”

Failed Fax Delivery Alert
This alert is triggered by an unusually high number of faxes that were not 
delivered to the target DN. Faxes can be delivered to the incorrect target if t
is a problem with the application setup. For more information, see Chapter 
“Alerts.”
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Section B: Generating alerts

In this section
 Overview of generating alerts 136

 Adding alerts to the Nortel Reporter window 137

 Defining nonbusiness hours for an alert 141

 Using alerts 143
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Overview of generating alerts

Introduction

To generate alerts, you must ensure that OMs are downloaded regularly fro
each of your Nortel Networks servers to your PC client. Once OM data has 
downloaded from a particular server, alerts are triggered by occurrences th
meet or exceed their particular thresholds. 

Note: If you have not set up a download schedule for each server, see Secti
“Downloading OMs,” on page 35.

Alerts and multiple servers

If you have more than one server in your organization, you must generate 
different alerts for each server. For example, if Server X has a history of fax
transmission problems, you can run the Failed Fax Delivery Alert. If Server 
experiencing networking problems, you can run the Networking Failures Ale
To ensure that hackers do not infiltrate your organization, you can run the 
Excessive After-Hours Logons Alert for both servers.

Organizing alerts for multiple servers

If you have many servers in your organization, it can be difficult to keep trac
the alerts that are generated for each server. The tree view in the Nortel Re
window organizes alerts on a per-server basis. Navigate to a server and do
click its folder. The tree expands to show you a list of all the alerts that are 
currently in use for the selected server.

The Nortel Reporter window

The Nortel Reporter window acts as a palette where you can store alerts th
currently in use for each of your servers. All of the alerts listed in this windo
can be printed, exported, or customized. If you no longer require an alert, y
can remove it from the Nortel Reporter. A permanent copy of the alert is kep
the New Report dialog box so that you can add it to the Reporter window w
necessary. 
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Adding alerts to the Nortel Reporter window

Introduction

You must add alerts to the Nortel Reporter window before you can work wit
them. To help you get started, the Nortel Reporter window contains six aler
that are used regularly. If you require additional alerts, you can add them to
Nortel Reporter window as needed.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To add alerts to the Nortel Reporter window

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Double-click the Alerts folder.

4 Select the Alerts Reports tab.

Result: The right panel displays all of the Alerts reports.
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5 On the File menu, click New.

Result: The New report or alert dialog box opens.

6 Make sure Alert is selected.

7 Click the alert you want to add to the Nortel Reporter window.
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8 Click OK.

Result: The Properties dialog box appears.

9 In the Report Name box, type a name for the alert, or accept the default.

10 In the Threshold box, enter an appropriate threshold.

11 In the Comments box, type additional information about the alert.

12 Click OK to return to the Nortel Reporter window.

Result: The selected alert is added to the Nortel Reporter window. You can 
now run, print, or customize the selected alert.
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Removing an alert from the Nortel Reporter window

If you seldom use an alert, consider removing it from the Nortel Reporter 
window. 

Example
During the last two months, you have used the Failed Fax Delivery Alert to 
monitor fax transmission errors. However, the problem has now been solve
and you do not need this alert anymore. To prevent the alert from taking up s
in the Nortel Reporter window, you remove it.

What happens when you remove an alert

When you remove an alert, the icon associated with the alert is removed from
Nortel Reporter window. However, a permanent copy of the alert remains on
New Report dialog box.

To remove an alert

1 In the Nortel Reporter window, select the alert you want to remove.

2 From the File menu, click Delete.

Result: A confirmation dialog box appears.

3 Click Yes to confirm the deletion and return to the Nortel Reporter window.
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Defining nonbusiness hours for an alert

Introduction

Since hackers often try to infiltrate an organization at times when employees
equipment are less active, you can use after-hours alerts to detect hacker ac
For example, if your company’s business hours are 9:00 a.m. to 5:00 p.m., 
hackers are most likely to attack the system late at night or early in the morn

Alerts that require after-hours definition

The following alerts notify you of suspicious occurrences outside of regular 
business hours. To use these alerts, you must first specify the hours of the 
that your company considers after-hours, or nonbusiness hours:

� Excessive After-Hours Logons Alert

� Excessive Thru-Dialer Access Alert 

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.
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Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window 

To define Alert Hours

1 On the Customize menu, click Alert Hours.

Result: The Alert Hours dialog box appears.

2 In the Alert Hours dialog box, check each day of the week that is a business 
day. 

Note: By default, Monday to Friday are checked.

3 In the Start Time box, type the hour at which nonbusiness hours begin (for 
example, 6: 00 PM).

4 In the End Time box, type the hour at which nonbusiness hours end (for 
example, 12: 00 AM).

5 To specify an entire nonbusiness day (for example, a holiday or weekend), 
leave the appropriate day unchecked.

Note: Saturday and Sunday are automatically unchecked.

6 Click OK to return to the Nortel Reporter window.
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Using alerts

Running an alert

If you want to see what an alert report looks like when it is printed, you can
display the alert on the screen.

Tips

Here are some tips for viewing alerts:

� To increase or decrease the size of the alert, click the size percentage 
at the top of the screen.

� To scroll through the pages one at a time, use the left and right arrow 
buttons.

� To print the alert, click the printer icon. For more information on printing
alerts, see “Printing and exporting alerts” on page 157. 

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports >Nortel Reporter 
window
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To run an alert report

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Double-click the Alerts folder.

4 Select the Alert Reports folder.

Result: The right panel displays all of the Alert reports.

5 Click the alert that you want to run.

6 On the File menu, click Run Report.

Result: The Reporting Interval dialog box opens.

7 In the Start Date box, select the date of the first day’s worth of data that you 
want to include in the alert report (for example, Mon 07 / 06 / 00).

8 In the Start Time box, select the time of the first day’s worth of data that you 
want to include in the alert report (for example, 1: 00 PM).

9 In the End Date box, select the date of the last day’s worth of data that you 
want to include in the alert report (for example, Wed 07 / 08 / 00).

10 In the End Time box, select the time of the last day’s worth of data that you 
want to include in the alert report (for example, 5: 00 PM). 
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11 Click OK.

Result: The alert report displays on the screen.

12 Click the Print icon to print the report.
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Duplicating an alert

If you want to create an alert quickly and easily, make a duplicate of an exis
alert and customize it to suit your needs.

To create an alert from an existing alert

1 Click the alert on which you want to base the new alert.

2 On the File menu, click Duplicate.

Result: The new alert appears in the Nortel Reporter window.

Note: Reporter automatically assigns a number to the alert. For example, if 
you duplicate the Failed RN Sessions Alert, the duplicate alert is named 
Failed RN Sessions Alert (1).

Clearing an alert

Clear an alert to remove the warning icons from the Nortel Reporter window
to stop the Communicator icon from flashing. Also clear an alert if you have
already run it and decided what to do.

To clear an alert

1 Select the alert you want to clear.

2 From the File menu, click Clear alert.
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Section C: Customizing the data in 
alerts 

In this section
 Overview of customizing alerts 148

 Setting the threshold for an alert 150

 Sorting the data in an alert 153

 Adding comments to an alert 155
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Overview of customizing alerts

Introduction

Customize an alert to eliminate excessive data and organize the remaining 
information into an easy-to-read format. Well-organized alerts make interpre
data easier.

Note: You can customize only the data contained in an alert. The boxes liste
an alert are predefined and cannot be changed.

How alerts can be customized

There are three ways to customize an alert:

� defining a threshold 

� sorting 

� adding comments

Defining a threshold

Define a threshold for an alert to specify the number of events that must oc
before the alert is triggered. For example, if the threshold value for the Exce
After-Hours Logons Alert is set to 25, the alert is triggered when 26 or more
after-hour logons occur.

Sorting

This method lets you organize the data displayed in an alert so that relevan
information is grouped together. This makes it easier to analyze and interpr
information.
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Example
The Excessive After-Hours Logon Alert shows all users with a suspicious 
amount of after-hours activity. You use the sorting feature to group all these
users according to the date and time at which they logged on.

Adding comments

Add comments to an alert to specify additional information about the data. 
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Setting the threshold for an alert

Introduction

When you execute an OM download, each alert compares the data copied 
the server to a predefined number or “threshold.” Whenever the threshold v
is exceeded, the alert is triggered. For example, if the threshold value for th
Excessive After-Hours Logons Alert is set to 25, the alert is triggered when 2
more after-hour logons occur.

Note: Because the Reporter application resides on your PC client, alerts ca
be generated until after an OM download takes place. This means that the 
you receive are not generated in real-time, as they occur. For example, if yo
Excessive After-Hours Logons Alert threshold is reached at 3:00 p.m. and y
OM download is not scheduled until 5:00 a.m., you will not receive an alert u
after the download has finished.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports > CallPilot 
Administration Client > CallPilot System > Reporter window
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To set the threshold for an alert

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Double-click the Alerts folder.

4 Select the Alert Reports folder.

Result: The right panel displays all of the Alert reports.

5 Click the appropriate alert.

6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the General tab.
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8 In the Threshold box, type the maximum number of occurrences that will 
trigger the alert.

Example: If the threshold value for the Excessive After-Hours Logons Alert 
is set to 5, when 6 or more after-hour logons occur, the alert is triggered.

9 Click OK.
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Sorting the data in an alert

Introduction

Sort the data in an alert to ensure that relevant information is grouped toge
This makes it easier to analyze and interpret information.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports > CallPilot 
Administration Client > CallPilot system > Reporter window

To sort the data contained in an alert

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Double-click the Alerts folder.

4 Select the Alert Reports folder.

Result: The right panel displays all of the Alert reports.

5 Click the alert you want to sort.
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6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the Sorting tab.

8 From the Sort by list, select the criterion you want to use as a sorting 
parameter.

Note: Some alerts cannot be sorted. If the Sorting tab does not appear, 
you cannot sort the alert.

9 To reverse the order of the criteria, make sure Descending is selected.

10 To choose additional sorting parameters, repeat steps 4 and 5.

11 Click OK to return to the Nortel Reporter window.
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Adding comments to an alert

Introduction

Add comments to the data in an alert to ensure that additional information is
forgotten or overlooked.

Note: Comments are visible only on the screen. They do not appear when t
alert is printed.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window
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To add comments to an alert

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

3 Double-click the Alerts folder.

4 Select the Alert Reports folder.

Result: The right panel displays all of the Alert reports.

5 Click the appropriate alert.

6 From the File menu, select Properties.

Result: The Properties dialog box opens.

7 On the General tab, in the Comments box, type the additional information 
about the alert.

8 Click OK to return to the Nortel Reporter window.
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Printing alerts

Introduction

Print alerts to help you identify significant patterns and trends related to sys
usage. 

Print schedule

You can print alerts according to a preset print schedule, or you can print re
on demand. You can also schedule an alert to print as soon as it has been 
triggered. Set up a print schedule so you can view the results of your alerts
a period of time. 

Setting an alert’s print schedule

Set up a print schedule to print alerts daily, weekly, or monthly. You can als
schedule alerts to print as soon as they are triggered. When you print alerts
regularly, you can identify patterns and trends related to system usage.

All alerts print to the default printer specified in the Windows Control Panel.

Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To set an alert’s print schedule

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.
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2 Select a CallPilot server.

3 Double-click the Alerts folder.

4 Select the Alert Reports folder.

Result: The right panel displays all of the Alert reports.

5 Click the alert for which you want to set a print schedule.

6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the Print Schedule tab.

8 Make sure the Print report on an ... basis box is checked.

9 If you want to specify how often the alert prints, select a frequency from the 
Print report list, and then go to step 7.

10 If you want the alert to print as soon as it is triggered, select If triggered 
from the Print report list.

11 Select or type the date in the Next print will occur on box to set the date on 
which you want the alert to print.
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12 Select the time in the at box to set the time at which you want the alert to 
print. 

13 To change the number of days of data included in the alert, enter the 
number of days’ worth of data in the Include ... day(s) worth of data in 
report box.

14 Click OK to return to the Nortel Reporter window.

Printing an alert on demand

Print an alert on demand when you do not want to wait for the print schedu
execute.

All alerts print to the default printer specified in the Windows Control Panel.

To print an alert on demand

1 Click the alert you want to print.

2 On the File menu, click Print Report.

Result: The Reporting Interval dialog box opens.

3 In the Start Date box, type the start date for data printed in the alert.

4 In the Start Time box, type the start time for data printed in the alert.
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5 In the End Date box, type the end date for data printed in the alert.

6 In the End Time box, type the end time for data printed in the alert.

7 Click OK to return to the Nortel Reporter window.

Printing a list of alerts

If you want to keep a list of alerts for future reference, print the contents of 
Nortel Reporter window.

All alerts print to the default printer specified in the Windows Control Panel.

To print a list of alerts

1 Double-click the Alerts folder on the left pane of the Nortel Reporter 
window.

2 Click the Alert Reports folder in the left pane of the Nortel Reporter window.

3 On the File menu, click Print List.
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Exporting alerts

Overview of exporting alerts to other programs

Export an alert to change its current file format to the file format of an extern
program. This can be useful if you want to view the alert on the World Wide
Web, over an organizational intranet, or in a spreadsheet program. You can
customize the alert information.

Limitation

When you export an alert, some formatting can be lost or modified. 

File formats

The file formats to which alerts can be exported include the following:

File format File extension Version

Character-separated 
values

(CSV) n/a

Comma-separated 
values 

(CSV) n/a

Crystal Reports (RPT) n/a

Data Exchange Format (DIF) n/a

Excel (XLS) 2.1

3.0

4.0

5.0

HTML .htm Draft Standard

Explorer 2.0

Netscape 2.0
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Before you begin

Use the tree view on the left side of the Nortel Reporter window to select th
appropriate server. For more information, see “Organizing alerts for multiple 
servers” on page 136.

Getting there  CallPilot Administration Client > Utilities > Reports > Nortel Reporter 
window

To schedule an alert to export to an external program

1 On the left panel, double-click the CallPilot Administration Client.

Result: One or more CallPilot servers appear.

2 Select a CallPilot server.

Lotus 1-2-3 WK1

WK3

WK5

1.0

2.0

3.0

ODBC Data Sources n/a

Paginated Text .txt n/a

Record Style (columns 
of values)

.rec n/a

Alert Definition .txt n/a

Rich Text Format RTF n/a

Tab-separated text .ttx n/a

Tab-separated values .tsv n/a

Text .txt n/a

Word for Windows .DOC n/a

File format File extension Version
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3 Double-click the Alerts folder.

4 Select the Alert Reports folder.

Result: The right panel displays all of the Alert reports.

5 Click the alert you want to export.

6 On the File menu, click Properties.

Result: The Properties dialog box opens.

7 Click the Output Options tab.

8 Make sure Export report to the following format is selected.

9 In the Export report to the following format list, type the format in which you 
want the alert exported.
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10 Click Save As.

Result: The Save As window opens.

11 Select the directory in which you want the exported file to be stored. 

Result: If you do not select a directory, the alert is exported to your root 
directory.

12 Click Save to return to the Nortel Reporter window.
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System status reports

In this chapter 
 Service Quality Summary Report 168

 Service Quality Detail Report 171

 Channel Usage Report 174

 Multimedia File System Usage Monitor Report 177

 Disk Usage Report 179
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Service Quality Summary Report

How to use this report

This report summarizes the level of activity for each type of channel installed
your system. Use this report to assess the service level each channel type 
provides to callers to the system. 

The report allows you to determine whether there are adequate channel 
resources or whether the minimum/maximum channel settings in the SDN t
need adjustment to provide the quality service needed for callers to the sys

Use this report to determine

� how many callers are forced to wait before accessing a channel

� how many callers abandon their calls

Additional information

This report requires traffic OM data.

This report is available only to CallPilot systems that are connected to the M
switch.

Report data

This report provides the following information:

Column Description

Date The date of the reporting period.

Time Period The time of the reporting period.

All Channels Busy 
(mm:ss)

The length of time in minutes and seconds that all the 
channels on your system were busy.

Voice Waited The number of callers who waited for a voice channel.
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How many callers waited for a channel?

Check the number of callers who waited for a voice, fax, or speech recogni
channel. 

If the voice, fax, or SR waited field = 0 for all time periods during a business
day, then the system is providing perfect service and, therefore, has adequ
resources for that type of channel.

If callers are waiting, then the service levels are less than perfect. To raise 
service levels requires either additional channel resources or reallocation o
system resources.

Suggested actions

� Check the SDN Table to see if one of the services has a minimum cha
setting that might be unnecessarily tying up channels and preventing ca
to other services from getting a channel without waiting. Reduce the 
minimum channels guaranteed for one service to improve service quali
callers to other services.

� Check the SDN Table to see if one or more of the services have a maxi
channel setting that prevents callers to the service from getting a chan

Voice Abandoned The number of callers who abandoned their calls while 
waiting for a voice channel.

Fax Waited The number of callers who waited for a fax channel.

Fax Abandoned The number of callers who abandoned their calls while 
waiting for a fax channel.

SR Waited The number of callers who waited for a speech recogniti
channel. 

SR Abandoned The number of callers who abandoned their calls while 
waiting for a speech recognition channel.

Column Description
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without waiting. Increase the maximum to reduce the chance of callers
waiting for a channel to get to the service.

� The number of voice, fax, and SR traffic channels might be out of balan
with the busy hour voice, fax, and SR traffic. For example, if fax channe
are under-utilized but callers to SR channels have to wait, you might 
consider reallocating some fax resources to SR. This requires a new 
keycode and possibly additional channel capacity. Contact your distribu

� Run the Service Quality Detail Report for more information about how 
long callers waited before accessing a channel. Refer to “Service Quality 
Detail Report” on page 171.

How many callers abandoned calls?

Check the number of callers who abandoned a voice, fax, or SR channel. If
large number of callers abandon their calls, they might be frustrated with lo
wait times.

Suggested actions

� If callers are abandoning their calls because of frustration over long wa
times, you can implement one of the following options:

� Increase the number of channels on the system (contact your 
distributor).

� Use the SDN Table to reallocate existing channels. For example, if a
large number of callers are waiting to access voice channels, you ca
configure more channels for voice.

� Run the Channel Usage Report to view the state of each individual cha
Refer to “Channel Usage Report” on page 174.
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Service Quality Detail Report

How to use this report

This report provides detailed information about the grade of service provide
each type of channel. These details can help you to improve the efficiency w
which callers access your services. Use this report to

� follow up on results from the Service Quality Summary Report 

� determine how long callers waited before accessing a voice, fax, or SR
channel

� determine how many callers abandoned their calls to a specific type of
media

Additional information

This report requires traffic OM data.

This report is available only to CallPilot systems that are connected to the M
switch.

Report data

This report provides the following information:

Column Description

Date The date of the reporting period.

Time Period The time of the reporting period.

Media Type The media type of the channels reported. They are voic
fax, or SR. The numeric values are 1= voice, 2 = fax, 3 
SR.

Number of Callers Waited The number of callers who waited.
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How long did callers wait before accessing a channel?

Check the average wait time for each type of media. If callers wait a long tim
before they access a resource, they might become frustrated and abandon
calls.

Suggested actions

� Check the SDN Table to see if one of the services have a minimum cha
setting that might be unnecessarily tying up channels and preventing ca
to other services from getting a channel without waiting. Reduce the 
minimum channels guaranteed for one service to improve service quali
callers to other services.

� Check the SDN Table to see if one or more of the services have a maxi
channel setting preventing callers to the service from getting a channe
without waiting. Increase the maximum to reduce the chance of callers
waiting for a channel to get to the service.

� The number of voice, fax, and SR traffic channels might be out of balan
with the busy hour voice, fax, and SR traffic. For example, if fax channe
are under-utilized but callers to SR channels have to wait, consider 
reallocating some fax resources to SR. This requires a new keycode an
possibly additional channel capacity. Contact your distributor.

Percentage Calls Waited The percentage of calls that waited.

Average Wait Time 
(mm:ss)

The average time a caller waited.

Maximum Wait Time 
(mm:ss)

The maximum time a caller waited.

Number of Callers 
Abandoned

The number of callers who abandoned their calls while 
waiting.

Column Description
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How many callers abandoned calls to a specific type of media?

Check the media type and the number of abandoned calls. If many callers 
abandon their calls to a particular media type, you might not have enough 
channels configured for that media type. For example, if callers abandon ca
fax channels because of lengthy wait times, you can configure additional 
channels to handle fax.

Suggested actions

� If callers are abandoning their calls to a specific media type because o
frustration over long wait times, consider increasing the number of 
channels that handle the type of media.

� Run the Channel Usage Report to view the state of each channel. This
ensures that your channels are operating correctly. Refer to “Channel Usage 
Report” on page 174.
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Channel Usage Report

How to use this report

This report summarizes the traffic handled by each channel on your system
this report to identify

� traffic distribution patterns

� problems with specific channels

� short call durations

Additional information

This report requires traffic OM data.

You can print this report as a graph.

Report data

This report provides the following information:

Column Description

Date The date of the reporting interval.

Time Period The time of the reporting interval.

Channel Number The number of the multimedia channel.

Incoming Calls The number of incoming calls on each channel.

Outgoing Calls The number of outgoing calls on each channel.

Total Calls The total number of incoming and outgoing calls on eac
channel.
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Is traffic evenly distributed across your channels?

Compare the number of ingoing and outgoing calls for each channel. The 
average amount of traffic for each channel should be similar. If a channel sh
no incoming or outgoing calls, the channel might be disabled or faulty.

Suggested actions

Use the Multimedia Channels program and the DS0 Channels program to c
the channel’s state.

� If the channel is disabled, use the Maintenance program to enable the 
channel.

� If the channel is faulty, use the Maintenance program to run diagnostic
the channel.

Avg. Hold Time Incoming 
Calls

The average hold time in seconds of incoming calls on 
each channel.

Avg. Hold Time Outgoing 
Calls

The average hold time in seconds of outgoing calls on t
channel.

CCS/Erlang CCS: The amount of traffic, in centa-call seconds (CCS)
that the channel handled per hour, during the period (the
numbers are rounded to the nearest integer, with the tot
being the total of the rounded integers.) A single channe
can handle a maximum of 36 CCS.

Erlangs: The number of Erlangs are rounded to two 
decimals, with the total being the total of the rounded 
numbers. A single channel can handle a maximum of 1 
Erlang.

Note: Information is shown in either CCS or Erlangs. Fo
more information see, “Changing the traffic units for a 
report” on page 98.

Column Description
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Is Average Hold Time unusually short?

Compare the number of incoming calls with the length of each call. Channe
with a high number of incoming calls but low CCS times mean that calls are
very short. Channels with unusually short Average Hold Time (AHT) might 
indicate a problem with that channel.

Suggested action
Run the traffic reports to obtain more information about the problem. Refer 
Chapter 7, “Traffic reports.”
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Multimedia File System Usage Monitor Report

How to use this report

Use this report to determine whether the system has sufficient disk volume 
storage to handle the current messaging and multimedia applications.

If a multimedia File System Volume becomes full, users with mailboxes on t
volume cannot create or receive any new messages. Therefore, it is very 
important that a volume is not allowed to fill up.

A major alarm is raised when a volume capacity reaches 90%. A critical alar
raised when a volume capacity reaches 95%.

Additional information

This report requires traffic OM data.

You can print this report as a graph.

Report data

This report provides the following information:

Column Description

Date The date of the information.

Time The time of the information.

Volume ID The ID of the storage volume. Volumes are sections on t
Nortel Networks disk.

Voice Capacity (hh:mm) The amount of voice storage space available in hours a
minutes.
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Is your capacity over 90 percent?

Suggested actions

� Check the time on the report. Storage usage often fluctuates during the
For example, storage generally peaks right before the start of the work
day when users are not available to receive voice or text messages.

� Storage usage also varies over the course of a week. Read messages
deleted automatically each night. On Friday, storage usage is high but 
Monday, storage usage is low as there are no new read messages ove
weekend.

� Run the Top Users of Storage Report to identify mailboxes that are sto
too many messages (refer to “Top Users of Storage Report” on page 2
You can reduce the message retention time, reduce message length 
parameters, or move mailboxes with high-usage volumes to low-usage
volumes. Only technical support personnel and Distributors can move u
from one volume to another. 

� Increase the storage capacity of the system. Contact your distributor.

� Check the Alarm Monitor to see if there are any events indicating proble
with the MMFS and its nightly audit. There might be a problem that is 
preventing the space held by deleted messages from being recovered.
these events exist, contact your distributor immediately.

Voice Used (hh:mm) The amount of voice storage space used in hours and 
minutes.

Percentage of Voice Used The percentage of voice capacity that is currently in use

Text Capacity (kbytes) The amount of text space currently available, in kbytes.

Text Used (kbytes) The amount of text space currently used, in kbytes.

Column Description
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Disk Usage Report

How to use this report

Use this report to determine whether the system has sufficient disk drive sto
The first disk drive holds:

� the Operating System

� the CallPilot software

� the CallPilot database

� the first Multimedia volume VS1

The size of your Multimedia volume depends on the number of hours that a
purchased.

A larger CallPilot system might have additional disk drives containing additio
Multimedia volumes (VS102, VS103). The size of these addtional volumes 
depends on the number of hours that are purchased.

Additional information

This report requires traffic OM data.

You can print this report as a graph.

Report data

This report provides the following information:

Column Description

Date/Time Period The date and time period of the report.

Disk Drive The disk drive used.
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Check available disk space

Compare the disk capacity to the percentage of disk space used.

Suggested actions 
If the report indicates that the disk drive is full, call your Distributor.

Note: The CallPilot system continues to operate; however, future upgrades 
might be affected.

Disk Capacity (kbytes) The amount of disk space currently available, in kbytes.

Disk Used (kbytes) The amount of disk space used, in kbytes.

Percentage Disk Used The percentage of disk space used.

Column Description
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In this chapter 
 Administration Action report 182
Reporter Guide 181



Administration reports  Standard 1.0

Pilot 

y 

m is 
tility 
Administration Action report

How to use this report

Use this report to obtain high level information on changes made to the Call
system by administrators. This information can be useful if you need to 
determine 

� changes made to CallPilot

� which administrator made those changes

� the client from which those changes were made

Additional information

The actions for this report are grouped under the Create, Delete, and Modif
subgroups.

The Administration Action report is the default report for the Administration 
category. A copy of this report is generated automatically when a new syste
created. Existing systems generate this report by running the New Reports u
of the Reporter Application.

Report data

This report provides the following information:

Column Description

Date The date when the action was generated.

Time The time when the action was generated.

Administrator Name The full name of the administrator responsible for 
executing the changes.

Action Type This can be Create, Modify, or Delete.
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Limitations

The Administration Action report does not provide specific information abou
modified items. The collected data only indicates that a modification has 
occured.

The Affected Item filtering criteria filters all actions according to a specific ite
As the content of this item varies greatly, use another filtering  item to creat
proper filtering criteria.

You cannot print this report as a graph.

Client Network Address The network IP address for the client.

Object The item or items that are affected from this action. The
are as follows:

� Users

� Mailbox Class

� SDL

� Message Delivery

� Messaging Administration

� Outcalling Administration

� Security Administration

� RPL

� Messaging Network

� Internet Mail

� System Prompt

� Application Builder

� Service DN

Description A high-level description of the changes.

Column Description
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Traffic reports

In this chapter 
 Productivity Report 186

 System Traffic Summary Report 189
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Productivity Report

How to use this report

Use this report to obtain information on productivity gains from using the 
CallPilot system. This information can be useful if you need to demonstrate

� the quantity of service provided by CallPilot

� the cost effectiveness of CallPilot

� an economic justification for CallPilot services 

Additional information

This report requires traffic OM data. 

Report data

This report provides the following information:

Field Description

Calls Summary

Number of Incoming Calls The number of calls that came in to the CallPilot system

Number of Outgoing Calls The number of outgoing calls originated by the CallPilot
system.

Total Calls The total number of incoming and outgoing calls to the 
CallPilot system.

Total Connect Time 
(Hours)

The total amount of connect time in hours due to all call
to and from the CallPilot system.

Equivalent Person Weeks The number of 40-hour person-weeks required to handl
the same service that CallPilot provided during the 
specified date/time interval.
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Messaging Sessions

Number of Express Voice 
Messaging Sessions

The total number of express voice messaging sessions.

Number of Call Answering 
Sessions

The total number of call answering sessions.

Number of Express Fax 
Messaging Sessions

The total number of express fax messaging sessions.

Number of Fax Call 
Answering Sessions

The total number of fax call answering sessions.

Number of Logon 
Sessions

The total number of logon sessions.

Number of Speech- 
Activated Messaging 
Sessions

The total number of speech-activated messaging sessio

Messages Created

Number of EVM/CA Voice 
Messages

The total number of voice messages created by Expres
Voice Messaging and Call Answering.

Number of EFM/FCA Fax 
Messages

The total number of fax messages created by Express F
Messaging and  Fax Call Answering.

Number of Logon Voice 
Messages

The total number of voice messages created during any
type of session, including DTMF log on, voice/fax log on
or SAM.

Number of Logon Fax 
Messages

The total number of fax messages created during any ty
of session, including DTMF logon, voice/fax log on, or 
SAM.

Other Activity

Field Description
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Application Builder The total number of AppBuilder sessions.

Remote Notification The total number of remote notification attempts.

Deliveries to Telephone The total number of delivery to telephone attempts.

Fax Deliveries The total number of fax delivery attempts.

Enterprise Networking The total number of Enterprise Networking calls.

AMIS Networking The total number of AMIS Networking sessions. This 
includes Integrated and Open AMIS.

Field Description
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System Traffic Summary Report

How to use this report

This report summarizes information about traffic patterns in your CallPilot 
system. Use this report to identify

� busy hours for your system

� services that are not being used

� services that are generating an unusually high amount of traffic

� periods when users have trouble logging on

� users who are not responding to their voice mail

Additional information

This report requires billing OM data.

You can print this report as a graph.

Report data

This report provides the following information:

Column Description

Date/Time Period The date and time period of the report.

Service Name The name of the service, such as call answering, that w
accessed.

Total Accesses The total number of accesses made to the service.

Average Hold time 
(mm:ss)

The average length, in minutes and seconds, of an acce
to the service during the specified period.
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Identify busy hours for your system

Run this report with the interval set for one day, midnight to midnight. A bar
graph is generated showing the traffic and accesses for each hour of the da
From this graph, it is possible to observe peak hours for traffic. 

Note: If the reporting interval is 24 hours a day or less, the graph displays a
of data for each hour. Otherwise, the graph shows a bar of data for each da

Suggested action

� Run the service quality summary report to see if there are callers waitin
abandoning during the busy hour. If they are, then the System Traffic 
Summary Report tells what services they are trying to reach and can a
identifying which services should have minimum and maximum channe
adjusted in the SDN Table (see “System Traffic Summary Report” on page 
189).

Identify services that are not being used

Check the number of accesses for each service. If a service has a low num
accesses, the service might not be working properly, or users might not be a
that it exists. 

Suggested actions

� Ensure that the service has been installed on your CallPilot system.

� Ensure that the service is working correctly. 

CCS/Erlang The traffic in centa call-seconds (CCS) or Erlangs. The 
numbers in a CCS calculation are rounded to the neare
integer, with the total being the total of the rounded 
integers. The numbers in an Erlang calculation are round
to two decimals, with the total being the total of the 
rounded numbers.

Percentage of Period Total The percentage of total traffic that this service generate

Column Description
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� Ensure that users are aware of the service and have been properly train
use it. 

� Check the time of the reporting interval. In some organizations, it is nor
for certain services to be used less during some periods than others. 

Identify services that are generating an unusually high amount of 
traffic

Check the Total Accesses field. If the number of accesses is higher for this 
service than for other services listed in the report, you might experience sys
performance problems. 

Suggested actions

� Check that the high volume of traffic was not caused by an unusual eve
For example, if you work for an airline company that advertises a one-d
discount, expect unusually high usage statistics from a particular featu

� If the high traffic for a particular service is expected to continue, you ca
set a minimum number of channels that must be available to a service i
SDN table. You can also expand the system if the overall traffic is highe
than originally anticipated.

� If the problem is that a particular service is experiencing sporadic traffic
spikes, and it is a less important application than others (like call 
answering), then consider setting a maximum number of channels for t
service in the SDN Table.

Identify periods when users are having trouble logging on

If users are having trouble logging on to CallPilot at certain times, check the
level of traffic for that time period.

Suggested action

� Check to see if periods when users cannot log on coincide with peak tr
hours for your system. If so, consider adding resources or reallocating t
to better serve callers.

� Check the SDN Table for services with non-zero minimum channels 
settings and consider lowering the minimums.
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Identify users who are not responding to their voice mail

Compare the number of accesses with the logon count provided by the Voic
Messaging Activity Report (see “Voice Messaging Activity Report” on page 
205). If the logon count is low compared to the number of accesses, users 
accumulating several messages before logging on to listen to them. Too ma
accumulated messages lowers the amount of available disk space to the po
where overall system performance can be affected.

Suggested actions

� Encourage users to keep up to date with their voice mail and faxes.

� Reduce the maximum allowable message length or increase storage 
capacity of the system. Contact your distributor.

� Run the Call Answering/User Responsiveness report to identify users w
are not responsive (see “Call Answering/User Responsiveness Report”
page 194).
192 CallPilot



C h a p t e r  8

Messaging reports

In this chapter 
 Call Answering/User Responsiveness Report 194

 Inactive User Report 197

 Mailbox Call Session Summary Report 199

 Mailbox Counts Report 204

 Voice Messaging Activity Report 205

 Desktop Messaging Activity Report 209

 Fax Messaging Activity Report 210

 Messaging Usage Report 213

 Speech-Activated Messaging Report 216

 Top Users of Storage Report 219

 Users Exceeding Storage Limit Report 221 
Reporter Guide 193



Messaging reports  Standard 1.0

e 
 are 

ing 
r is 
e.
Call Answering/User Responsiveness Report

How to use this report

This report shows information about Call Answering (CA) and Express Voic
Messaging (EVM) on a per-user basis. Use this report to identify users who
not

� receiving voice messages

� logging on to their mailbox

Additional information

This report requires billing OM data.

Report data

This report provides the following information.

Column Description

Name The name of the mailbox owner.

Mailbox The mailbox number.

Date The date of the report interval.

Total CA+EVM Calls The total number of CA and Express Voice Messaging 
(EVM) calls.

No Msg CA+EVM Calls The total number of calls that resulted in no message be
left by the caller. A no-message call occurs when a calle
routed to CA for a mailbox and does not leave a messag
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Identify users who are not receiving messages

Compare the total number of no-message calls with the total number of CA
EVM calls. If there is a higher percentage of calls than messages, users are
hanging up without leaving a message, or are pressing 0 to speak to an atte

Suggested actions

� Ask users to review their greetings. If greetings are unfriendly or 
instructions are too complex, callers might hang up without leaving a 
message.

� Listen to the users’ greetings. 

� If a greeting indicates an extended absence, expect a high percenta
no-message calls. 

� If users have not recorded a greeting, ask them to record one as so
possible. If users are not available, record a temporary greeting on t
behalf.

� Provide users with additional training on how to compose and maintain
greetings.

Identify users who are not logging on to their mailbox

Compare the total number of CA and EVM calls to the number of logons. If
there are more messages than logons, users are not retrieving their voice 
messages.

Suggested actions

� Find out if a user is absent. If so, you can archive the user’s messages
tape.

Percentage Of No 
Message Calls

The percentage of no-message calls to total calls.

Logons The number of successful logons.

Column Description
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� Check the user’s greeting. If the user is absent but has not indicated th
his or her greeting, you can record a temporary absence greeting on h
her behalf. 
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Inactive User Report

How to use this report

This report shows users who are not maintaining their mailboxes. Use this re
to identify users who are not

� logging on to their mailboxes

� reading their messages

Additional information

This report requires billing OM data.

Report data

This report provides the following information.

Column Description

Name The user name associated with the mailbox. The report
shows only the users whose last logon session preceded
Last Logon date.

Mailbox The mailbox number of the user.

Unread Messages The number of messages that were left unread at the tim
of the last logon session. If this field is blank, the user h
not logged on during the range of dates in the database

Last Log on date The date of the last logon.

Last Log on Time The time of the last logon. If this field is blank, the user 
has not logged on during the range of dates in the datab
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Identify users who are not logging on to their mailboxes

Check the user name and the last logon date. If users are not logging on to
mailboxes regularly, your messaging system is not being used effectively.

Suggested actions

� Check to see if any users are on vacation or extended leave.

� Remind users that stored messages consume disk space.

� When users leave the company, ensure that their mailboxes are remov
from distribution lists. Unused mailboxes that are included on distributio
lists continue to store messages that are sent to their owners.

� Use the Mailbox Call Session Summary Report to follow up on lack of u
responsiveness (see “Mailbox Call Session Summary Report” on page 
199).

Identify users who are not reading their messages

Check the user name and the number of unread messages. If users store 
messages over a long period of time, a high percentage of disk space is us
This can result in poor system performance.

Suggested actions

� Remind users that stored messages consume disk space.

� Provide additional training for users.

� Use the Mailbox Call Session Summary Report to follow up on lack of u
responsiveness (see “Mailbox Call Session Summary Report” on page 
199).
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Mailbox Call Session Summary Report

How to use this report

This report provides information about each call session to a particular mai
during the reporting period. Use this report to 

� follow up on lack of user responsiveness 

� identify suspicious caller DNs and long sessions that might indicate ha
activity

� investigate user complaints of delayed messages

Additional information

This report requires billing OM data.

Report data

This report lists each call made to a mailbox during the reporting period and
provides the following details: 

Column Description

Header: User Name, 
Mailbox Number

Indicates the user’s name and the mailbox number.

Date/Time The date and time of the call.

Session Length The length of the session in hours, minutes, and second
(hh:mm:ss).
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Session Type The type of session: 

VM—Voice Messaging

MM—Multimedia Messaging

EVM—Express Voice Messaging

SAM—Speech Activated Messaging

CA—Call Answering

FCA—Fax Call Answering

EFM—Express Fax Messaging

This field includes the count of invalid logon attempts.

Caller DN The telephone number (either internal extension or 
external phone number) that originated the call to the 
mailbox. This field can contain up to 17 digits.

CA/EVM Voice Msg 
Received

The total number of voice messages left during the CA 
EVM session. 

FCA/EFM Fax Msg 
Received

The total number of fax messages that arrived during th
FCA or EFM session.

Msg Read The total number of voice and fax messages that were r
during the logon session.

Msg Sent The number of voice and fax messages that the user se
during the logon session. 

Msg Unread The total number of unread voice and fax messages at 
end of the session.

Column Description
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Identify sources of low user responsiveness

Identify sources of low user responsiveness by looking at the following field

� Add the values in the CA+EVM Msg Received and FCA/EFM Fax Msg
Received fields. Compare this total to the value in the Msg Read field. If
number of read messages is lower than the total of the messages rece
the user is not listening to all of his or her messages. 

� Check the Session Type field to find users who do not log on often (few
VM, MM, or SAM sessions). 

� Check the Msg Unread field for unread messages at the end of a sess

Suggested actions

� If users are not logging on to their mailboxes or listening to messages, s
they need additional training.

� If a user is reporting delayed messages, check to see if unread messa
(Msg Unread field) exist at the end of the logon sessions. If they do, th
user might think the messages were not delivered until the next logon t
Some users might need training in how to retrieve messages.

Session End Indicator Shows how the session ended:

� applications error

� hung up

� time-out

� log off

� log on

� transfer

� switched to fax mode

� unknown

Transfer DN If there was a call transfer during the session, this is the
DN to which the caller was transferred.

Column Description
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Identify suspicious caller DNs

If you suspect that a hacker is trying to access or has gained access to a 
particular mailbox, look at the sessions for that mailbox and identify the call
DNs. One of the DNs calling in to the mailbox could belong to the hacker.

Suggested actions
Enable Hacker Monitor to track suspicious caller DNs (referred to as CLIDs
Hacker Monitor). Whenever a monitored DN calls in to the system and logs
to a mailbox or places a thru-dial call, an alarm is generated in real time to n
you.

Identify long sessions

Check the Session Length field for especially long sessions (particularly CA
logon sessions). These indicate that a hacker has accessed the mailbox an
found a way of thru-dialing from your system to place long distance calls. O
in a mailbox, the hacker can set up a session and leave it open for a long ti
sell services.

Suggested actions

� Check the status of the mailbox and its owner. Is the user actively using
mailbox, on vacation or extended leave, or no longer with your compan

� If the mailbox is unused because the user is no longer with your compa
delete the mailbox immediately. Unused mailboxes are the targets of 
hackers and must be removed. 

� If the user is temporarily away, you can either change the user’s passw
or disable the mailbox until the user returns.

� If the mailbox is active, inform the user of the situation and ask the use
change the password immediately. Give the user tips on how to create
secure passwords. 

� Monitor the mailbox regularly.
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Identify short sessions ending with a transfer

Look for mailboxes with a number of short logon sessions ending with a 
transfer. This is strong evidence that someone is using the mailbox just to p
calls.  

Suggested actions

� Check if the mailbox is used by a current employee.

� Check if the greeting suggests that the employee is not checking his or
mailbox.

� Check the restriction/permission list of the Mailbox Class to which the 
mailbox belongs.

� Force a password change to block further access.

� Enter the Caller DN of repeat callers into the hacker monitor.
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Mailbox Counts Report

How to use this report

This report counts the number of mailboxes by mailbox class, department, 
switch location. Use this report to get statistical information about the numbe
mailboxes in each department or switch location.

Additional information

You do not need to collect OM data to generate this report.

Report data

Column Description

Mailbox Counts 
(Mailbox Class) Report

Mailbox Class The name of the mailbox class.

Mailbox Count The total number of mailboxes.

Mailbox Counts 
(Department) Report

Department The department name.

Mailbox count The total number of mailboxes.

Mailbox Counts 
(Switch Location ID) Report

Switch Location ID The name of the switch location.

Mailbox Count The total number of mailboxes.
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Voice Messaging Activity Report

How to use this report

This report summarizes the voice messaging activity on your CallPilot syste
Use this report to

� identify a high number of calls and long messages

� identify high numbers of abandoned calls

� identify discrepancies between the number of sessions and the numbe
messages

� gain an understanding of the number and length of each type of messa
session

Additional information

This report requires billing OM data.

Report data

 

Column Description

Date The date of the reporting interval.

Time Period The time of the reporting interval.

CA/EVM Sessions The number of Call Answering (CA) and Express Voice 
Messaging (EVM) sessions during the specified time 
period.

Logon Sessions The number of voice messaging logon sessions during 
specified time period.
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Identify a high number of calls and long messages

Compare the number of calls with the average message length. Too many c
a short period of time, combined with users leaving long messages, ties up
channels and prevents others from accessing the CallPilot system.

Suggested actions

� Reduce the maximum allowable length for messages.

� Consider expanding your system.

Speech-Activated 
Messaging Sessions

The number of Speech-Activated Messaging sessions 
during the specified time period.

Desktop Message Transfer The number of new voice messages received by clients

Average Session Length 
(sec.)

The average length in seconds of CA, EVM, and logon 
sessions for the specified time period.

Maximum Session Length 
(sec.)

The longest length in seconds of CA, EVM, and logon 
sessions for the specified time period.

Call Answering Messages 
Created

The number of CA messages created during the specifi
time period.

Logon Messages Created The number of logon messages created during the 
specified time period.

Average Message Length 
(sec.)

The average length of messages in seconds created du
the specified time period. Since message length affects
disk storage, use this information to determine whether 
enough disk space has been allocated for voice messag

Maximum Message 
Length (sec.)

The longest message created during the specified time 
period.

Column Description
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Identify a high number of abandoned calls

Compare the number of CA or EVM messages to the total number of CA or
EVM sessions. If there are fewer messages than sessions, callers are aban
their calls.

Suggested actions

� Ask users to review their greetings. If greetings are unfriendly or 
instructions are too complex, users might hang up without leaving a 
message.

� Listen to users’ greetings. 

� If a greeting indicates an extended absence, expect a high percenta
no-message calls. 

� If users have not recorded a greeting, ask them to record one as so
possible. If the users are not available, record a temporary greeting 
their behalf.

� Provide users with additional training on how to compose and maintain
greetings.

Identify discrepancies between the number of sessions and the 
number of messages

Compare the total number of CA sessions with the total number of CA mess
created. The number of sessions should match or be similar to the number
messages created. If there are more sessions than messages, this means t
reaching the CA greeting, users are hanging up without leaving a message
they are pressing 0 to transfer to an attendant. Callers might hang up witho
leaving a message if they are not familiar with the service. If hackers thru-d
out of your system during a CA session, you will receive CA sessions but n
messages.

Suggested actions

� Users might need some training on using CA and EVM.

� Users should review their greetings. If greetings are unfriendly or 
instructions are too complex, callers might hang up without leaving a 
message. 
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� Run the Call Answering/User Responsiveness Report to determine wh
mailboxes have a high percentage of no-message calls (see “Call 
Answering/User Responsiveness Report” on page 194).

� If you suspect hacker activity, check the restriction/permission list that 
assigned to the Call Answering/Express Voice Messaging Thru-Dial 
feature. You can also examine the Excessive Incomplete Messaging 
Accesses Alert (see “Excessive Incomplete Messaging Accesses Alert
page 308). 
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Desktop Messaging Activity Report

How to use this report

This report summarizes the activity for the Desktop Messaging program on 
CallPilot system. Use this report to determine how many

� voice messages are received by clients

� fax messages are received by clients

Additional information

This report requires billing OM data.

Report data

. 

Identify number of fax messages received by clients

Check the New Fax Presented field.

Identify number of voice messages received by clients

Check the New Voice Presented field.

Column Description

Date The date that the activity took place.

Time Period The start and end time between which the activity took 
place.

New Voice Presented The number of new voice messages received by clients

New Fax Presented The number of new fax messages received by clients.
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Fax Messaging Activity Report

How to use this report

Use this report to summarize the fax messaging activity on your CallPilot 
system. This report gathers fax usage statistics for individual mailbox users

Additional information

This report requires billing OM data.

Report data

Column Description

Date The date of the reporting period.

Time Period The time of the reporting period.

Fax Call Answering 
Sessions

The number of times callers were routed to Fax Call 
Answering on the CallPilot system.

Express Fax Messaging 
Session

The number of times callers dialed the Express Fax 
service, which allows them to leave a fax message in a 
specific mailbox.

Call Answering Faxes 
Created

The number of fax messages created after callers were
routed to the CallPilot system.

Express Faxes Created The number of fax messages created after callers diale
the Express Fax service.

Logon Faxes Created The number of fax messages created by users logged o
the CallPilot system.
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How much fax traffic does each mailbox user handle?

Check the following fields to obtain information about the volume of fax traff
handled by each user:

� Call Answering Faxes Created

� Auto Attendant Faxes Created

� Average Fax Size (pages)

� Desktop Message Transfers

Suggested action
Assign users who handle a high volume of faxes to a mailbox class with mo
storage capacity.

Are callers leaving fax messages?

Compare the number in the Fax Call Answering Sessions field with the num
in the Call Answering Faxes Created field. Compare the number in the Fax A
Attendant Sessions field with the number in the Auto Attendant Faxes Crea
field. If the number of sessions is much greater than the number of faxes cre
then callers might not understand how to leave a fax message, or a nonexis
mailbox might be specified for Fax Auto Attendant.

Suggested actions

� Review the prompts used for Fax Call Answering to determine if they c
be made more direct and helpful. If so, rerecord the prompts.

Average Fax Size (pages) The average number of pages that make up one fax 
message.

Fax Print Sessions The number of fax messages printed by users logged on
the CallPilot system.

Desktop Message 
Transfers

The number of new fax messages received by clients.

Column Description
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� If only one mailbox is specified for Fax Auto Attendant, make sure the 
mailbox number is correct.
212 CallPilot



April 2000 Messaging reports 

lbox 
es 
e this 

rs 
n 

d 
Messaging Usage Report

How to use this report

This report provides a daily summary of how many system resources a mai
is using. It reports on the amount of channel, storage, and network resourc
used, as well as the aggregate number of messages sent and received. Us
report to gather statistics for a mailbox’s 

� resource usage 

� messages sent and received

Additional information

� Before running or printing this report, specify a period of at least 24 hou
in the Reporting Interval dialog box. This ensures that the information i
your report spans a significant length of time.

� This report requires billing OM data.

Report data

Column Description

Name The first and last name of the mailbox owner.

Mailbox # The number of the mailbox.

Date The date for which mailbox usage data is provided.

Channel Connect Time 
(sec)

The total amount of time that the mailbox was connecte
to a channel on the specified date.

Note: The channel connect time does not include 
outcalling time.
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How much messaging traffic does each mailbox user handle?

Check the following fields to obtain information about the volume of messag
traffic handled by each user:

� Messages Sent

� Messages Received

� Storage (kbytes)

� Number of SAM sessions

Storage (mm:ss) The average amount of disk space used by the mailbox
the specified day, in minutes and seconds. This include
the amount of space taken up by voice messages, fax 
messages, and greetings.

Storage (kbytes) The average amount of disk space used by the mailbox
the specified day, in kbytes.

Number of SAM Sessions The number of Speech-Activated Messaging sessions t
occurred on the specified date.

Desktop Message 
Transfers

The number of new voice and fax messages received b
clients. 

Messages Received The total number of messages received by the mailbox 
the specified date.

Messages Sent The total number of messages originating from the 
mailbox on the specified date.

Total The average amount of disk space used per mailbox on
specified date.

Grand Total The average amount of storage space used per mailbox
during the reporting interval.

Column Description
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Suggested action 
Assign users who handle a high volume of messages to a mailbox class wit
more storage capacity.

Are there long channel connect times?

Check the Channel Connect Time (sec) field for lengthy connections. These
might indicate that hackers are using the mailbox to place outcalls. 

Suggested actions

� Check the status of the mailbox and its owner. Try to determine if there
reason for the lengthy connections. Is the user actively using the mailb
on vacation or extended leave, or no longer with your company? 

� If the mailbox is unused because the user is no longer with your 
organization, delete the mailbox immediately. Unused mailboxes are tar
for hackers and must be removed. 

� If the user is temporarily away, you can either change the user’s passw
or disable the mailbox until the user returns.

� If the mailbox is active, inform the user of the situation and ask the use
change the password immediately. Give the user tips on how to create
secure passwords.

� Monitor the mailbox regularly.
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Speech-Activated Messaging Report

How to use this report

This report summarizes information about each Speech-Activated Messagi
(SAM) session to a particular mailbox. Use this report to gather SAM usage
statistics for individual users who have reported trouble with SAM.

Additional information

This report requires trace OM data. 

Report data

 

Column Description

Header: User Name, 
Mailbox number

The last name and first name of the mailbox user, and t
number of the mailbox.

Date/Time The date and time of the session.

Session Length The length of the session.

Caller DN The directory number from which the call originated.

Total Unsuccessful Logon 
Attempts

The total number of unsuccessful Speech Recognition 
(SR), Dual-tone multifrequency (DMTF), and Mixed 
logon attempts during the attempted SAM session.  

Unsuccessful SAM Logon 
Attempts

The number of unsuccessful logon attempts to SAM usi
SR.

Unsuccessful DTMF 
Logon Attempts

The number of unsuccessful logon attempts to SAM usi
DTMF.
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Unsuccessful Mixed 
Logon Attempts

The number of unsuccessful logon attempts to SAM usi
either SR or DTMF.

Logon Result 0 = success with SR

1 = success with DTMF

2 = success with SR and DTMF

3 = max. invalid

4 = hung up 

5 = canceled

6 = timed out

7 = locked out

Total Recognitions The total number of attempted recognitions of user spee
(utterances) by the speech recognizer.

Accepted Recognitions% The percentage of attempted recognitions by SR that w
successful and did not require a confirmation query of th
user. These occurred because the speech recognizer w
statistically confident it understood the users utterance.

Queried Recognitions% The percentage of attempted recognitions by SR that w
successful but required a confirmation query of the user
These occurred because the speech recognizer though
understood the user’s utterance, but it was statistically 
unsure and thus queried the user to confirm.

Rejected Recognitions% The percentage of attempted recognitions by SR that 
failed. These occurred because the speech recognizer d
not understand the user’s utterance and thus had to ask
user to try again.

DTMF Switches The number of switches from SAM to DTMF (either 0 
or 1).

Column Description
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High percentage of Queried or Rejected recognition attempts

A high percentage of Queried or Rejected recognition attempts indicates tha
user was struggling to be recognized during this SAM session. If the user 
switched to DTMF, then the user “gave up” on using SR for this session.  

Suggested actions
This might be a one-off SAM session for a user who normally has success 
SR. There might have been temporary factors that affected SR performanc
such as a bad connection or noisy background, a user not speaking normal
to fatigue, or other factors. This would be indicated if other SAM sessions fo
this user do not show problems.

However, some users consistently have problems with SR. Typically, users
experience the greatest difficulty with having their mailbox number and 
password being recognized successfully. Once they are successfully logge
they can use the SAM commands. Users who fit this profile can try some of
following alternatives:

� If the phone is not in an open office environment, program the mailbox 
autologon to eliminate the need to speak the mailbox number and 
password.

� If users are calling from a wireless telephone, have them program the 
mailbox number and password into speed-dial.

� Remind users that if they are calling from a DTMF phone, they can use
DTMF whenever prompted for a number, including mailbox number, 
password, or addresses when composing a message.

� If users are using SAM because they occasionally pick up messages fr
rotary phone and do not have DTMF, then set up a SAM service that u
Paced Digit Recognition. It is slower but much more reliable at recogniz
a mailbox number and passwords.
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Top Users of Storage Report

How to use this report

Use this report to display the top 50 users of storage as of the date specifie
the report.

Additional information
� This report requires traffic OM data.

� You must run the system to be reported on for at least one full day (24 
hours) before the data in this report is valid.

Report data

Column Description

Name The name associated with the mailbox.

Mailbox The number of the mailbox.

Storage Used (mm:ss) The total storage used by the mailbox, including greeting
in minutes and seconds, taken at the date noted beneath
report title.

Storage Used (fax pages) The total amount of disk storage used by the user, in fax
pages.

Storage Used (Kbytes) The total amount of disk storage used by the user, in 
kbytes.

Mailbox Class The mailbox class for the mailbox.

Switch Location The name of the switch location.
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Which users are using the most storage?

Check the mailbox number and the total amount of disk storage taken up by
user. Storage of messages for long periods of time or storing too many mes
can reduce system performance. 

Suggested actions

� Remind users that stored messages take up valuable space.

� Ask users to delete old messages.

� If you suspect that users are exceeding their storage limit, run the Use
Exceeding Storage Limit Report. 
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Users Exceeding Storage Limit Report

How to use this report

Use this report to identify users who are exceeding the storage limit establi
by their mailbox class.

Additional information

This report requires traffic OM data.

Report data

 

Box Description

Name The user name associated with the mailbox.

Mailbox The number of the mailbox.

Storage Used (mm:ss) The total storage used by the user’s mailbox, including 
greetings, in minutes and seconds, taken at the date no
beneath the report title.

Storage Limit (mm:ss) The maximum storage allowed by the mailbox class.

Percent Above Limit The storage exceeding the mailbox class, as a percenta

Mailbox Class The mailbox class of the mailbox.

Switch Location ID The switch location of the mailbox.
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Which users are exceeding their storage limit?

Check the following fields for information about users who are taking up mo
than their allotted percentage of disk space:

� Percent Above Limit

� Storage Used (mm:ss)

� Storage Limit (mm:ss)

� Mailbox Class

If too many users exceed their storage limit, system resources are tied up, 
reducing overall system performance. 

Suggested actions

� Contact the appropriate users and ask them to delete old messages.

� Reduce the message retention period set in Mailbox Classes. 

� Prevent mailboxes from accepting messages when they are full.

� Ask technical support to move users who need large amounts of storag
volumes on the hard disk that have more available storage space. 

Note: Administrators do not have this permission.

� Run the Call Answering/User Responsiveness Report to see if users a
checking their messages (see “Call Answering/User Responsiveness 
Report” on page 194). If users are not checking their messages, find out 
they are on extended leave. If a user is absent and his or her mailbox i
exceeding capacity, you can archive his or her messages to tape. 
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Building Block Summary Report

How to use this report

Use this report to determine if you need to redesign any applications create
with Application Builder. This report collects information about how certain 
building blocks are accessed by callers during a defined time period. This h
you to determine if callers are using the blocks efficiently. 

Graph format

For this report, you must generate graphs on a block-by-block basis. You ca
generate one graph for the entire report. Make sure the following criteria ar
selected on the Selection Criteria property page: 

Additional information

This report requires billing OM data.

Item Operator Value

Block Name Is Equal To Type the name of the 
appropriate block.

ServiceAppID Is Equal To Type the appropriate 
ServiceAppID.

Block Type Is Equal To Choose the appropriate 
block type:

1=Announcement

2=Thru-Dial

3=Call Transfer

4=Fax Select 

5=menu
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Report data
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Column Description

ServiceAppID The unique number used to identify the AppBuilder 
application in which the block resides. If the applicatio
is in the Service DN Table, then the application is calle
a service.

Block Name The name given to the block when it was placed in the
application.

Block Type The type of block. This report records information for 
five types of blocks:

� Announcement

� Call Transfer

� Fax Select

� Menu

� Thru-Dial

Date and Time Period The date and time the report data was collected for th
block.

Number of Times Each Key 
Has Been Used

The total number of times that callers pressed keys on
the phoneset to interact with the block.

Number of Accesses The number of times this block was reached/accesse

Number of Abandonments The number of calls that were abandoned while in this
block.

Average Access Time The average amount of time callers interacted with the
block.

# of Faxes Selected The number of faxes selected by callers in an 
application that contains Fax Select blocks.
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Types of blocks

Before you can effectively use the information in this report, you must 
understand the difference between the types of blocks. The report informat
applies differently to each block.

In general, AppBuilder applications use two categories of blocks—building 
system. This report is concerned with building blocks, which are combined 
create voice and fax applications. System blocks are used in voice and fax 
applications that provide links to existing applications on the system.

In particular, this report is concerned with five types of building blocks— 
Announcement, Call Transfer, Fax Select, Menu, and Thru-Dial.

Announcement
The Announcement block provides the primary way to play voice in an 
application.

Call Transfer
The Call Transfer block transfers callers to the default attendant or an exten
of their choice.

Fax Select
The Fax Select block contains a fax document that a caller can select for sa
call or callback delivery.

Menu
The Menu block gives callers options and their corresponding keys on the 
phoneset.

Thru-Dial
The Thru-Dial block provides an automated attendant service that transfers
callers to the extension of their choice.

How many times did callers press keys?

By looking at the # of Accesses field, you can determine how many times ca
pressed keys for each block. A large number of key presses for a block can
indicate unnecessary or misplaced information, or hacker activity.
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Unnecessary or misplaced information
If the # of Accesses field contains a large number for an Announcement blo
then callers are pressing keys on the phoneset to interrupt and bypass the 
announcement.

A large number implies one of the following situations: the announcement is
unnecessary, it needs to be repositioned elsewhere in the application, or it 
to be configured so that callers cannot interrupt it.

Hacker activity
Check the # of Accesses field for the Thru-Dial block. If the field contains a 
large number for this block, someone might be using the application to try to
place calls to long distance numbers. To discourage hacker activity, you can
password-protect the Thru-Dial block. As well, you can ensure that its 
restriction/permission list does not allow long distance calls.

How long did callers use a block?

Look at the Average Access Time field for any block. If the average time is lo
callers could be experiencing difficulty interacting with that particular block.

Consider how a block and its related voice items can hinder a caller’s 
interaction. For example, if callers take a long time at the Thru-Dial block, th
they probably do not understand how to enter the number that they want di
If callers take a long time at the Menu or Fax Select blocks, they do not 
understand the choices associated with these blocks or how to indicate a c
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DTT Activity Report

How to use this report

This report monitors use of the Delivery to Telephone (DTT) service. Use th
report to determine

� how much the service is being used

� if messages are being delivered

� whether the DTT service is able to acquire channels when needed

� whether the DTT retry settings are adequate

Additional information

This report requires traffic OM data.

Report data

 

Column Description

Date/Time Period The date and interval of the specified reporting period.

New Requests The total number of new requests for message delivery t
were made to the DTT service during the reporting perio
A request is made whenever a user tries to compose an
send a message to a telephone number that does not ha
mailbox defined in your system.
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Is the service being used?

Check the number of new requests. A low number can indicate minimal use
the DTT service. This can be caused by lack of awareness of the service am
users, or lack of knowledge of how to use the service.

A low number of requests can also indicate a very restrictive RPL. Since the
address is checked when the message is composed, a request is not made
number is restricted.

Retry Failures The number of times the DTT service tried to resend 
messages that could not be delivered because the retry
limit was reached or exceeded. DTT tries to resend a 
message when a call attempt results in a busy, no answ
or answer (but no Dual-tone multifrequency confirmation
condition up to the number of times defined as the retry
limit. If the user entered an address restricted by the 
switch, the attempt is counted as a retry failure.

Other Failures The number of DTT call attempts where the call could n
be completed. A failure can indicate that a message 
became stale or that the user entered an address restric
by the RPL assigned to DTT. 

Average Wait Time 
(mm:ss)

The average amount of time that the DTT service had to
wait during the reporting period to acquire a channel to 
make the outcall. 

Maximum Wait Time 
(mm:ss)

The longest amount of time that the DTT service had to
wait during the reporting period to acquire a channel to 
make the outcall. 

Blocked Attempts The number of DTT attempts that were blocked due to t
unavailability of channels.

Column Description
Reporter Guide 231



Outcalling reports  Standard 1.0

 
 that 

 

mber 
er of 

ery 

e too 

s to 

ry 

lows 
ed, the 

is 
Suggested actions

� Find out if users know about the feature and how to use it. 

� If necessary, provide users with additional training.

� Requests are denied if the telephone number is restricted. Check the 
restriction/permission list assigned to DTT/DTF in your mailbox classes
and check NCOS, TGAR, and CLS settings on the switch to make sure
delivery to the required external phone numbers is allowed.

� If the restricted numbers are appropriate, inform users of the restricted
numbers to which they are not allowed to address messages.

Are messages being delivered?

Compare the number of successes to the number of new attempts. If the nu
of successes is lower than the number of attempts (or there is a high numb
failures), messages are not being delivered. 

Suggested actions

� Check the DTT setup in Outcalling Administration. 

� Make sure the economy delivery time overlaps with the allowed deliv
times.

� Make sure the stale time setting is not causing messages to becom
old too soon.

� Check the average wait time, maximum wait time, and blocked attempt
see if the DTT service is having problems acquiring channels.

� Check the retry failures to see if the DTT retry limits are causing delive
failures.

� Check if the RPL assigned to DTT was changed. If the logon session al
a user to compose a message to an address but the RPL is later chang
request fails and is logged under Other Failures.

Are allocated channel resources adequate?

High values in the following fields can indicate that the current channel 
allocations for the DTT service are insufficient for the amount of traffic DTT 
generating: 
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� Average Wait Time

� Maximum Wait Time

� Blocked Attempts

Suggested actions
Increase the minimum or maximum number of channels, or both, allocated 
the DTT service. Do this in the SDN Table by modifying the outbound SDN 
assigned to DTT. If you do not have enough channels to handle the traffic, y
might have to purchase additional channels or change the allocations for ot
services.

Are retry limits appropriate?

If the number of retry failures is high, the retry limits for DTT might be too lo

Suggested action
Increase the DTT retry limits that are defined in Outcalling Administration.
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DTT Audit Trail Summary Report

How to use this report

Use this report to determine which call attempts are responsible for the high
retry counts and failures detected by the DTT Activity Report.

Additional information

This report requires traffic OM data.

Report data

Column Description

Name The name of the mailbox owner.

Mailbox The mailbox number from which the call originated.

Date The date the call was made.

Time The time the call was made.

Duration (hh:mm:ss) The duration of the call in hours, minutes, and seconds.

Target Phone Number The telephone number that was called.
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Call Status The result of the call in a numeric return code:

4 = Operation successful

14 = Could not reach destination: The phone number 
dialed is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of message delivered; fax parts exist b
were not delivered

19 = Fax parts of message delivered; voice parts exist b
were not delivered

22 = Invalid destination number or Bad/Invalid Address

Retry Counter The total number of retry attempts that were made at th
time of the call attempt. This field increments by one ea
time.

Column Description
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DTT Audit Trail Detail Report

How to use this report

Use this report to monitor DTT usage.

Additional information

This report requires traffic OM data.

Report data

Box Description

Name The name of the mailbox owner.

Msg ID The identification number of the message.

Target Phone Number The telephone number that was called.

Date The date the call was made.

Time The time the call was made.

Duration (hh:mm:ss) The length of the call in hours, minutes, and seconds.

Call Retries The total number of retry attempts that were made. This
field increments by one each time.
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Process Type One of the following audit trail entry types displays:

1 = Server process. This could be a submission of a new
request, the rescheduling of a request, or the removal o
request.

2 = Agent made a call.

3 = Agent attempted to make a call but failed. This could
be due to restriction/permission settings, problems with t
switch (for example, no dial tone) or configuration.

Call Status The result of the call in a numeric return code:

4 = Operation successful

14 = Could not reach destination: The phone number 
dialed is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of multimedia msg delivered; fax parts 
exist but were not delivered

19 = Fax parts of multimedia msg delivered; voice parts
exist but were not delivered

22 = Invalid destination number or Bad/Invalid Address

Action The action performed on the request. The possibilities 
include

1 = Reschedule

2 = Remove

3 = Add

Box Description
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Reason Why an action occurred in a numeric code

1 = Answer limit exceeded

2 = Busy limit exceeded

3 = No answer limit exceeded

4 = End of period

5 = User logon

6 = RN disabled

7 = New message arrival

8 = Delivery OK

9 = Delivery failed

10 = Message deleted

11 = Message read

12 = Invalid DN

Channel Number The DN of the channel used to place the call.

Box Description
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Fax Deliveries Activity Report

How to use this report

This report monitors Delivery to Fax (DTF) and fax printing activity over a 
specified time period. This means you get reports on fax deliveries to non-
mailbox numbers (Delivery to Fax) as well as fax callback numbers entered
callers who have accessed services created with Application Builder that co
Fax Send blocks. In this last instance, the DTF service is also used to delive
faxes to callers. Use this report to determine

� how much these services are being used

� if messages are being delivered

� whether the DTF service is able to acquire channels when needed

� whether the DTF retry settings are adequate

Additional information
� This report requires traffic OM data.

� You can print this report as a graph.

Report data

 

Column Description

Date/Time Period The date and time interval of the specified reporting 
period.

New Requests The total number of new requests for fax delivery that 
were made during the reporting interval. A request is 
counted whenever a user tries to forward a fax to a 
mailbox, or a telephone number that is not a mailbox, o
when a caller into an Application Builder service reques
that a fax be delivered to a callback number.
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New Attempts The total number of attempts made to process the new 
requests for DTF and fax printing services during the 
specified time period.

Retries The number of times that the DTF service retried 
delivering faxes that could not be delivered. DTF retries
fax delivery when the destination fax device is busy or 
there is no answer, or when there is a transmission failu

Successes The total number of successful fax deliveries during the
specified time period.

Retry Failures The number of times that faxes could not be delivered 
because the retry limit was reached or exceeded. The 
system retries delivery attempts if the destination fax 
machine is busy or does not answer, if the connection 
cannot be made, or if there is a transmission error. If the
target fax number is restricted by the switch, the attemp
counted as a retry failure.

Other Failures The number of times faxes could not be delivered for 
reasons other than retry failures. A failure logged in this
field can indicate that a fax became stale or that the targ
fax number is restricted in the RPL. 

Average Wait Time 
(mm:ss)

The average amount of time the system waited to acquir
channel to deliver faxes. 

Maximum Wait Time 
(mm:ss)

The longest amount of time the system had to wait to 
acquire a channel to deliver a fax. 

Blocked Attempts The number of fax delivery attempts that were blocked 
because channels were not available. 

Column Description
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Are the services being used?

Check the number of new requests. If the number is low, callers might not b
aware that the service exists, or they might not understand how to use the 
feature. Also, there could be a hardware or software problem.

A low number of requests can indicate a very restrictive RPL. Since the add
is checked when the message is composed, a request is not made if the num
restricted.

Suggested actions

� Make sure the prompts recorded for the Application Builder service are
worded clearly. 

� Look for ways to promote the applications to users and callers (in the c
of Application Builder services). 

� Requests are denied if the fax number is restricted. Check the restrictio
permission list assigned to DTT/DTF in your mailbox classes and chec
NCOS, TGAR, and CLS settings on the switch to make sure that deliver
the required external fax numbers is allowed.

� If the restricted numbers are appropriate, inform users of the restricted
numbers to which they are not allowed to send faxes.

� If the Application Builder service has been restored from backup, make
sure the service has been opened, checked, and saved. Otherwise, ca
hear an error prompt.

� Investigate technical problems and correct the situation.

Are messages being delivered?

If the number of successes is lower than the number of new attempts (or th
a high number of failures), faxes are not being delivered. 

Suggested actions

� Check the DTF setup in Outcalling Administration. 

� Make sure the economy delivery time overlaps with the allowed deliv
times.

� Make sure the stale time setting is not causing faxes to become too
too soon.
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� Check the average wait time, maximum wait time, and blocked attempt
see if the DTF service is having problems acquiring channels.

� Check if the RPL assigned to DTT/DTF was changed. If the logon sess
allows a user to send a fax to a particular fax number but the RPL is la
changed, the request fails and is logged under Other Failures.

� Check the retry failures to see if the DTF retry limits are causing delive
failures or if there are indications of problems with the destination devic

Are allocated channel resources adequate?

High values in the following fields may indicate that the current channel 
allocations for the DTF service are insufficient for handling the amount of tra
DTF is generating: 

� Average Wait Time

� Maximum Wait Time

� Blocked Attempts

Suggested actions

� Increase the minimum or maximum number of channels allocated to th
DTF service. Do this in the SDN Table by modifying the outbound SDN
assigned to DTF (and Multicast DTF, which is used to send broadcast 
messages). 

� If you do not have enough channels to handle the traffic, you might hav
purchase additional channels or change the allocations for other servic

Are retry limits appropriate?

Check the number of fax retries. Large numbers of retries indicate there we
problems making a connection to the destination fax machine (busy, no ans
no carrier, transmission error). 

Suggested actions

� To determine specific instances of high retries, run the Fax Audit Trail 
Summary Report for the corresponding time interval to see if the cause
due to no carrier or transmission errors (see “Fax Print Audit Trail 
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Summary Report” on page 251). If this is the case, contact the organizatio
to which you are sending faxes and ask them to examine their equipme

� Consider increasing some of the retry limits that are configured in 
Outcalling Administration.
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Fax On Demand Audit Trail Summary Report

How to use this report

This report provides summary information about Delivery to Fax calls placed
Application Builder services with fax callback capability. Use this report to 
investigate potential fax delivery problems that certain services are experien
For example, the Fax Deliveries Activity Report alerts you to the fact that a 
significant number of fax deliveries were unsuccessful due to retry failures. 
can generate the Fax on Demand Audit Trail or the Fax Deliveries Activity 
Report to get details such as the called DN and the reason for the retry failu
(no carrier versus transmission problems, for example).

Use this report to troubleshoot

� problems with an Application Builder service

� problems with a particular fax device

� the cause of lengthy fax delivery sessions

Additional information

This report requires traffic OM data.

Report data

Column Description

Date/Time The date and time of the fax delivery. 

Duration (hh:mm:ss) The length of the call in hours, minutes, and seconds.

Target Phone Number The destination DN (fax phone number) of the call.
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Call Status The result of the call, in a numeric return code:

4 = Operation successful

6 = Protocol error

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of message delivered; fax parts exist b
were not delivered

19 = Fax parts of message delivered; voice parts exist b
were not delivered

22 = Invalid destination number or Bad/Invalid Address

23 = Local system error

Successful Delivery Whether the fax was successfully delivered (Yes or No).

Service DN The Service Directory Number (SDN) of the Application
Builder service from which a caller requested fax deliver
to a callback number.

App Name The name of the service (application) from which a calle
requested fax delivery to a callback number.

Note: The App Name only shows the current information
associated with the Service DN. This information might 
not match the App Name at the time the call is made due
changes in the Service DN application or the application
session profile.

Column Description
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Is there a problem with an Application Builder service?

If callers are requesting faxes from a particular service and faxes are regula
not delivered, there could be a problem with the service setup. 

Check the Successful Delivery field for calls that were not successful. Then
check the SDN and App Name fields to see whether faxes requested from 
particular services are not being delivered.

Suggested action
Check the session profile of the Application Builder service (accessible from
SDN Table). If the page transmission error handling is set to Quit, then faxe
not delivered if there is an error. Set this option to Continue to allow the ser
to retry transmission.

Is there a problem with a particular fax device?

Faxes sent to a particular fax device might not be delivered if there is a prob
with the receiving fax device. The fax machine could be out of paper or turn
off, for example.

Check the Successful Delivery field for calls that were not successful. Then
check the Target Phone Number field to see if failed deliveries are associat
with the same DN(s). 

Billing DN The billing directory number of the application that 
originated the call.

Note: The Billing DN only shows the current information
associated with the Service DN. This information might 
not match the Billing DN at the time the call is made due
to changes in the Service DN application or the 
application’s session profile.

Column Description
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Suggested actions

� Contact the owner of the called DN to identify whether there is a proble
with the destination device.

� Run the Fax On Demand Audit Trail Detail Report.

Are there any lengthy sessions?

Check the Duration field for fax delivery sessions that are especially long. A
long session might indicate that hackers have gained access to an Applicat
Builder service with fax callback capability and are using it to send faxes to 
per-call numbers.

Suggested actions

� Take the Application Builder application out of service until the problem
fixed.

� Reduce the session time limit in the service’s SDN configuration.

� Follow up to see if the called DN is a pay-per-call number. If so, report y
findings to the system administrator.

� If the service allows toll calls, consider assigning a more restrictive 
restriction/permission list to the service.

� Consider using password blocks to require callers to enter passwords b
entering callback numbers that incur long distance charges.
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Fax On Demand Audit Trail Detail Report

How to use this report

This report traces the fax delivery process from the outcall request to the fin
outcome. Use it to help you determine why a specific fax delivery attempt h
failed. The results and the reason for the failure are provided. 

Additional information

This report requires traffic OM data.

Report data

 

Column Description

Target Phone Number The target DN of the fax delivery attempt.

Msg ID The unique number the system assigned to each Delive
to Fax request. This allows all requests to be tracked. 

Date The date of the fax delivery attempt.

Time The time of the fax delivery attempt.

Duration (hh:mm:ss) The length of the call in hours, minutes, and seconds. 

Service DN The Service DN of the service from which the callback fa
call originated.

Call Retries The total number of retries for this request that have bee
made since the first attempt to deliver the fax. After eac
attempt, the counter increments by one. (The first attem
is considered retry 0.)
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Process Type The type of audit trail entry:

1 = Server process. This could be a submission of a new
request, the rescheduling of a request, or the removal o
request.

2 = Agent made a call.

3 = Agent attempted to make a call but failed. This could
be due to restriction/permission settings, problems with t
switch (for example, no dial tone), or configuration.

Call Status The result of the call, in a numeric return code:

4 = Operation successful

6 = Protocol error

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of message delivered; fax parts exist b
were not delivered

19 = Fax parts of message delivered; voice parts exist b
were not delivered

22 = Invalid destination number or Bad/Invalid Address

23 = Local system error

Action The action performed on the request. The possibilities 
include

1 = Reschedule

2 = Remove

3 = Add

Column Description
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Reason Why an action occurred:

1 = Answer limit exceeded

2 = Busy limit exceeded

3 = No answer limit exceeded

4 = End of period

5 = User logon

6 = Disabled

7 = New message arrival

8 = Delivery OK

9 = Delivery Failed

10 = Message Deleted

11 = Message Read

12 = Invalid DN

Channel Number The DN of the channel used to place the call.

Column Description
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Fax Print Audit Trail Summary Report

How to use this report

This report tells you whether problems are with particular fax machines or a
associated with particular mailboxes. Use it to determine which fax printing 
attempts are causing high retry counts and failures. This report is used with
Fax Print Audit Trail Detail Report.

Additional information

This report requires traffic OM data. 

Report data

Column Description

Date The date of the fax printing attempt.

Time The time of the fax printing attempt.

Duration (hh:mm:ss) The length of the call in hours, minutes, and seconds.

Target Phone Number The DN of the fax device to which the fax was sent for 
printing.
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Is there a problem with a particular fax machine?

Check the Target Phone Number field to see if printing problems are occurr
with the same fax DN. 

Suggested actions

� Test the fax machine associated with the DN to see if there are problem

� To explore the cause of the problems in greater detail, run the Fax Prin
Audit Trail Detail Report (see “Fax Print Audit Trail Detail Report” on 
page 253).

Call Status The call in a numeric return code:

4 = Operation successful

6 = Protocol error

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of message delivered; fax parts exist b
were not delivered

19 = Fax parts of message delivered; voice parts exist b
were not delivered

22 = Invalid destination number or Bad/Invalid Address

23 = Local system error

Successful Delivery Whether the fax was successfully printed (Yes or No).

Name The first and last name of the user who printed the fax.

Mailbox The number of the mailbox from which the print request
originated.

Column Description
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Fax Print Audit Trail Detail Report

How to use this report

This report traces the fax delivery process from the print request to the fina
outcome. Use it to help you determine why a specific fax print delivery attem
failed. The results and the reason for the failure are provided. This report is
available only if Multimedia Messaging is enabled on your system. 

Additional information

This report requires traffic OM data.

Report data

Column Description

Target Phone Number The number of the fax machine to which the fax was se
for printing.

Msg ID The identification number assigned to the fax for trackin
purposes.

Date/Time The date and time of the printing attempt.

Duration (hh:mm:ss) The length of the call in hours, minutes, and seconds.

Mailbox The number of the mailbox that requested fax printing.

Call Retries The total number of retries for this request that have bee
made since the first attempt. After each attempt, the 
counter increments by one.
Reporter Guide 253



Outcalling reports  Standard 1.0

 
f a 

 
he 

led 

ut 

ut 
Process Type The type of audit trail entry:

1 = Server process. This could be a submission of a new
request, the rescheduling of a request, or the removal o
request.

2 = Agent made a call.

3 = Agent attempted to make a call but failed. This could
be due to restriction/permission settings, problems with t
switch (for example, no dial tone), or configuration.

Call Status The result of the call in a numeric return code: 

4 = Operation successful

6 = Protocol error

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of message delivered; fax parts exist b
were not delivered

19 = Fax parts of message delivered; voice parts exist b
were not delivered

22 = Invalid destination number or Bad/Invalid Address

23 = Local system error

Action The action performed on the request. The possibilities 
include

1 = Reschedule

2 = Remove

3 = Add

Column Description
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Are there recurring fax printing failures?

Repeated failures to print faxes could indicate problems with the channel 
hardware. Look at the Channel Number field to determine which channel w
acquired to print the fax. If the same DN keeps recurring along with printing
failures, this can indicate channel problems.

Reason Why an action occurred:

1 = Answer limit exceeded

2 = Busy limit exceeded

3 = No answer limit exceeded

4 = End of period

5 = User logon

6 = Disabled

7 = New message arrival

8 = Delivery OK

9 = Delivery Failed

10 = Message Deleted

11 = Message Read

12 = Invalid DN

Channel Number The DN of the channel used to place the call.

Column Description
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RN Activity Report

How to use this report

This report can help you to determining Remote Notification (RN) busy time
Use it to obtain information about Remote Notification activity during a 
specified time period. 

Use this report to troubleshoot

� low usage of the remote notification feature

� problems with restriction/permission lists applied to remote notification

� inadequate channel allocations for the service

Additional information

This report requires traffic OM data. 

Report data

Column Description

Date The date of the specified period.

Time Period The time of the specified period.

New Requests The number of new RN requests during the specified tim
period.
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Is the service being used?

A low number in the New Requests field can indicate low use of the RN serv
This might be due to a lack of awareness of the service among users or a la
knowledge of how to use the service. 

Retry Failures The number of RN attempts that failed because the use
did not log on to listen to new messages before the retry
limit was exceeded. This can indicate one of the followin
situations: 

� The notification could not be delivered because the 
retry limit was exceeded and RN for that message 
stopped. 

� The notification was delivered, but the user did not lo
on to listen to the new message. 

� The target DN is restricted on the switch.

Other Failures The number of RN attempts that failed due to reasons 
other than retry failures. A failure can occur if

� The RPL assigned to DTF was changed after an RN
request was accepted.

� A notification request occurs outside the allowed time
period.

Average Wait Time 
(mm:ss)

The average amount of time, in minutes and seconds, it
took the RN service to acquire channels to place 
notification calls during the specified time period.

Maximum Wait Time 
(mm:ss)

The longest amount of time, in minutes and seconds, it 
took for the RN service to acquire a channel to make a c

Blocked Attempts The total number of times that an RN attempt was block
because a channel could not be acquired.

Column Description
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A low number of new requests can also indicate that the RN server is out o
service or not working.

Suggested actions

� Find out if users know about the feature and how to use it. You might n
to provide users with additional training.

� Check the status of the RN server.

Are there excessive RN failures?

If the number of failed requests or other failures is high, notifications are no
getting to users, and there could be a technical or setup problem. 

Failures can indicate that the RPL assigned to RN changed after users set 
their target DNs.

Suggested actions

� A high number of failures can indicate that RN to pagers is not working
because of the pager setup. Check the pager configuration in your mai
classes.

� Contact your pager company. They might not have enough lines to han
the volume of pager requests. 

� Check the average wait time, maximum wait time, and blocked attempt
see if the RN service is having problems acquiring channels.

� If the RPL assigned to RN was changed, inform users of the numbers 
are now restricted so that they can update their target DNs.

� Run the RN Audit Trail Summary Report to isolate specific instances o
failure (see “RN Audit Trail Summary Report” on page 260).

Are allocated channel resources adequate?

High values in the following fields can indicate that the current channel 
allocations for the RN service are insufficient for the amount of traffic RN is 
generating: 

� Average Wait Time

� Maximum Wait Time
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� Blocked Attempts

Suggested actions
Increase the minimum or maximum number of channels or both, allocated to
RN service. Do this in the SDN Table by modifying the outbound SDN assig
to RN. If you do not have enough channels to handle the traffic, consider 
purchasing additional channels or changing allocations for other services.
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RN Audit Trail Summary Report

How to use this report

Use this report to determine which Remote Notification (RN) attempts are 
responsible for the high number of failures detected by the RN Activity Rep

Use this report to troubleshoot

� which call attempts are responsible for high recounts and failures

� whether there are problems with users’ RN setup

Additional information

This report requires traffic OM data.

Report data

Column Description

Name The name of the user to which the RN was made.

Mailbox The mailbox number from which the RN attempt 
originated.

Date The date of the call.

Time The time of the call.

Duration The duration of the call in minutes and seconds.

Target Phone Number The telephone or pager number that the mailbox called.
This is the target DN that is defined in the user’s RN set
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Which calls failed?

Determine which call attempts are responsible for the high retry counts and
failures.

Suggested action
Run the RN Audit Trail Detail Report to see the details of each request 
submitted by the RN service (see “RN Audit Trail Detail Report” on page 263).

Are there problems with users’ RN setup?

If calls that originate from certain mailboxes keep failing, there could be 
problems with the way users have set up their RN service. 

Suggested actions

� Check the Mailbox field to see if there are repeated RN failures from th
same mailbox. The user might have selected the wrong device type in h
her RN setup or entered the wrong PIN (if notification is to a pager). Ch

Call Status The result of the call, in a numeric return code:

4 = Operation successful

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

22 = Invalid destination number or Bad/Invalid Address

Retry Counter The total number of retries for this RN request that have
been made since the first attempt. After each attempt, th
counter increments by one. RN attempts are retried if, fo
the first attempt, the target DN is busy, not answered, or
answered without the user logging on to listen to new 
messages.

Column Description
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the user’s RN setup in User Manager, or ask the user to verify the devi
type and PIN in his or her RN setup.

� Check the Target Phone Number field to see if there are repeated RN 
failures to certain phone numbers. If so, the target DN defined by the u
might be invalid. From User Manager, check the user’s RN setup. Phon
target DN to see what happens. If you confirm that the number is not va
contact the user and ask him or her to change or delete the target DN.

� Check the user’s RN setup from User Manager to determine if the time
period is defined for too narrow a time.
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RN Audit Trail Detail Report

How to use this report

This report is typically run after the RN Audit Trail Summary Report. Use it 
see the details of each request submitted to the Remote Notification (RN) 
service. 

Use this report to troubleshoot

� unusual traffic patterns

� users not receiving RNs

Additional information

This report requires traffic OM data.

Report data

This report provides the following information:  

Column Description

Name The mailbox owner’s name.

Msg ID The identification number assigned to the message for 
tracking purposes.

Target Phone Number The telephone number that the mailbox called.

Date The date of the call.

Time The time of the call.

Duration The duration of the call in minutes and seconds.
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Call Retries The total number of retries for this RN request that have
been made since the first attempt. After each attempt, th
counter increments by one. RN attempts are retried if, fo
the first attempt, the target DN is busy, not answered, or
answered but the user does not log on to listen to new 
messages.

Process Type One of the following audit trail entry types is displayed:

1 = Server process. This could be a submission of a new
request, the rescheduling of a request, or the removal o
request.

2 = Agent made a call.

3 = Agent attempted to make a call but failed. This could
be due to restriction/permission settings, problems with t
switch (for example, no dial tone), or configuration.

Call Status The result of the call, in a numeric return code:

4 = Operation successful

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

22 = Invalid destination number or Bad/Invalid Address

Action The action performed on the request. The possibilities 
include

1 = Reschedule

2 = Remove

3 = Add

Column Description
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Are there unusual traffic patterns?

To check whether unusual traffic patterns are occurring, run the Channel U
Report (see “Channel Usage Report” on page 174). You can also check the
hardware and switch terminal number status.

Are there failed RNs?

If users complain about not receiving RNs, complete the following actions to
identify the potential cause:

� Call the target phone number yourself. If the number is not valid, conta
the user and ask him or her to change or delete the target DN.

� Set up an RN to your phone, and listen to the call.

Reason Why an action occurred:

1 = Answer limit exceeded

2 = Busy limit exceeded

3 = No answer limit exceeded

4 = End of period

5 = User logon

6 = RN disabled

7 = New message arrival

8 = Delivery OK

9 = Delivery Failed

10 = Message Deleted

11 = Message Read

12 = Invalid DN

Channel Number The DN of the channel used to place the call.

Column Description
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In this chapter 
 Networking Activity Report 268

 Open Networking Activity Report 272
Reporter Guide 267



Networking reports  Standard 1.0

nd 

er)
Networking Activity Report

How to use this report

This report monitors the messaging network activity between the local site a
remote sites within your messaging network. Use it to

� determine whether AMIS and Enterprise networking have access to 
sufficient channel resources for the networking traffic load

� determine the network message traffic levels to each remote site (serv

� identify high numbers of failed networking sessions

� identify high numbers of NDN messages

� identify high numbers of undelivered messages

� identify times when remote sites are not available

Additional information
� This report requires traffic OM data.

� You can print this report as a graph.

Report data

Column Description

Date The date of the specified reporting period.

Time Period The time of the specified reporting period.
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Protocol Possible values: 

� Enterprise

� AMIS 

� VPIM 

� unknown

Messaging Server The CallPilot server being monitored.

Messages Sent The total number of messages sent to the specified rem
site from the local site.

Messages Received The total number of messages received from the specifi
remote site.

Connect Time (mm:ss) The total connect time between the local and the remote
site, in minutes and seconds.

Total Sessions The total number of completed sessions with the specifi
remote site.

Failed Network Sessions The total number of outbound network session attempts
with the specified remote site, because a channel was n
available at the local site.

Blocked Attempts The total number of blocked sessions attempts with the
specified remote site, because a channel was not availa
at the local site.

Site Unavailable The number of times a session to the remote site failed 
because the network call was dropped or the network 
protocol failed.

NDN Messages Delivered The total number of NDN messages sent to remote use
whose messages could not be delivered to mailboxes o
the local system.

Column Description
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Does the network have sufficient capacity?

Check the Blocked Attempts field. A large number of blocked attempts can 
indicate that a channel was not available.

Suggested actions

� Check the SDN table to see if a maximum channel limit has been place
AMIS or Enterpise networking services. If so, increase the maximum.

� Install additional channels.

� Run this report with an interval that extends from midnight to midnight 
over a typical business day. The graph shows the total network connect
for each hour of the day.

� Compare the connect times for the busiest hour to the maximum possi
connect time (60 minutes for each channel times the maximum channe
allowed for AMIS or Enterprise in the SDN Table).

� The ratio of the connect time to maximum possible connect time is an 
approximate estimate of the probability that an inbound or outbound 
network attempt will be blocked.

� If the ratio exceeds 40 percent, consider increasing the maximum chan
for AMIS or Enterprise in the SDN table. If it is already set to the 
maximum, then consider adding more voice channel capacity to the loc
site.

Identify high numbers of failed sessions

Check the Failed Network Sessions field. A large number of failed sessions
indicate insufficient channel capacity at the remote site for handling the 
incoming networking calls.

Undelivered Messages The total number of messages that were not delivered. 
undelivered message occurs when a successful network
session to the remote site cannot be established before
message stale timer expires.

Column Description
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Suggested actions

� Increase the maximum channels for AMIS or Enterprise in the SDN tab
If it is already set to the maximum, then consider adding more voice 
channel capacity to the local site.

� Install more channels.

Identify high numbers of NDN messages

Check the NDN Messages Delivered field. A large number indicates that 
messages sent by local users are not being received by remote users. This
indicate incorrect configuration problems at the remote site.

Suggested actions

� Check your configuration.

� Alert the remote site’s administrator.

Identify high numbers of undelivered messages

Check the Undelivered Messages field. A message is undelivered when a 
successful networking session to a remote site cannot be established befor
message stale time expires. A large number of undelivered messages can 
indicate networking problems at the remote site. 

Suggested actions

� Adjust the stale time configuration.

� Alert the remote site’s administrator. If multiple sites are experiencing t
same problem, the local site’s networking is the likely source of the 
problem.

Identify times when remote sites are not available 

Check the Site Unavailable field. A large number of unavailable site occurre
indicates that a network call was dropped or the protocol failed. 
Reporter Guide 271



Networking reports  Standard 1.0

n 
e 

d 
s 

 

Open Networking Activity Report

How to use this report

This report shows the messaging networking activity of the local site to ope
remote sites. Use it to determine how efficiently your system is working. Th
information contained in the report indicates if your system is properly 
configured for the system traffic or if it requires modifications.

An open remote site is not included in your network database and is not 
considered part of the integrated messaging network. AMIS Networking an
VPIM Networking are the networking solutions that can exchange message
with open sites. 

Note: Networking activity to integrated sites that are part of your messaging
network is shown in the Networking Activity Report.

Use this report to check the number of

� blocked session attempts

� non-delivery notifications (NDN) and undelivered messages

� failed networking sessions

Additional information
� This report requires traffic OM data.

� You can print this report as a graph.

Report data

 

Column Description

Date Period The date of the specified period.

Time The time of the specified period.
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Identify high numbers of blocked sessions

Check the number of blocked session attempts. A large number can indicat
additional channels should be allowed for AMIS Networking. 

Suggested action
Consider increasing the maximum channels for AMIS in the SDN table.

Protocol AMIS or VPIM Networking.

Messages Sent The total number of messages received through open 
networking.

Messages Received The total number of messages received through open 
networking.

Connect Time (hh:mm:ss) The total connect time used by open networking session
in hours, minutes, and seconds.

Completed Sessions The total number of completed open networking session

Failed Sessions The total number of failed open networking sessions.

Blocked Session Attempts The total number of blocked session attempts with the 
specified remote site.

Site Unavailable The number of times an outgoing session was attempte
with an available port, but the session could not be 
established because the remote site was not respondin

NDN Messages Delivered The number of NDN messages returned to the local site

Undelivered Messages The total number of messages that were not delivered. 
undelivered message occurs when a successful network
session to the remote site cannot be established before
message stale timer expires.

Column Description
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Identify high numbers of NDNs

Check the number of NDNs and undelivered messages. If the number of N
delivered or the number of undelivered messages is high, there could be a 
problem with your networking setup or with the switch/telephone network. 
Since Open AMIS requires the user to enter the DN to dial at the destinatio
messaging system, the user might be addressing messages incorrectly.

Suggested action

Refer to the appropriate networking implementation and administration guid
for details on the proper setup of the networking features in your system.

Identify high numbers of failed networking sessions

Check the number of failed networking sessions. A high number can indica
problems between sites.

Suggested action
Contact your system administrator and the administrator of the site you are
trying to reach.
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Bill-back reports

In this chapter
 800 Access Bill-back Report 276

 DTT Usage Bill-back Report 278

 Messaging Usage Bill-back Report 280

 Network Usage Bill-back Report 282

 RN Usage Bill-back Report 284

 Fax on Demand Bill-back Report 286

 Fax Print Bill-back Report 288
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800 Access Bill-back Report

How to use this report

Use this report to monitor 800 service usage. Each call over an 800 facility 
specific mailbox is captured by name, mailbox, and department to allow for e
billing.

Additional information
� This report requires billing OM data.

� This report can be exported to a file that can be used with an external b
back program.

� If you set Department or Mailbox as the primary sorting criterion for this
report, the Length Subtotal field appears in the printed report.

Report data

Column Description

Date The date of the 800 call.

Time The time of the 800 call.

Length (sec.) The length of time of the call in seconds.

Called DN The VSDN that the call was terminated on.
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Session Type The type of session that the call originated from: 

VM—Voice Messaging

MM—Multimedia Messaging

EVM—Express Voice Messaging

SAM—Speech Activated Messaging

CA—Call Answering

FCA—Fax Call Answering

EFM—Express Fax Messaging

Last Name The last name of the mailbox owner.

First Name The first name of the mailbox owner.

Mailbox The mailbox number.

Department The department of the mailbox owner.

Mailbox Class The Class of Service (COS) of the mailbox.

Switch Location The name of the switch location.

Column Description
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DTT Usage Bill-back Report

How to use this report

Use this report to bill back the cost associated with telephone activity to the
appropriate user or department.

Additional information
� This report requires billing OM data.

� This report can be exported to a file format that can be used with an 
external bill-back program.

� If Department or Mailbox is specified as the primary sorting criterion fo
this report, the Call Hold Time Subtotal field appears in the printed repo

Report data

Column Description

Name The name of the user. 

Mailbox The mailbox number of the user.

Department The department of the user.

Date The date of the telephone call.

Time The time of the telephone call.

Call Hold Time (hh:mm:ss) The length of time that the user was on hold. 

Target DN The directory number that is being called.

Retry Counter The number of retries made to complete the call.
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Switch Location The name of the switch location.

Column Description
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Messaging Usage Bill-back Report 

How to use this report

Use this report to bill back the cost associated with telephone activity to a u
based on the messaging activity of his or her mailbox. This report shows th
total connect time and the new message time used by the specified mailbox

Additional information
� This report requires billing OM data.

� This report is normally exported to a file format that can be used with a
external bill-back program.

� If Department is specified as the primary sorting criterion for this report
the Session Length Subtotal field appears in the printed report.

Report data

Column Description

Name The name of the mailbox owner.

Mailbox The mailbox to which the messaging activity is billed.

Department The department to which the mailbox belongs.

Session Length (sec.) The total length of time in seconds that the mailbox was
used in Logon, Call Answering, or Visit Messenger 
sessions. If your system has submailboxes, a summary
connect time appears in the report.

Mailbox Class The mailbox class to which the mailbox is currently 
assigned.

Switch Location The name of the switch location.
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Total Storage (kbytes) The total amount of disk space used by the mailbox, in 
kbytes.

Date The session start date.

Column Description
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Network Usage Bill-back Report

How to use this report

Use this report to record the networking activity of users that resulted in lon
distance charges. This report is normally generated as an ASCII file that ca
used with an external bill-back program.

Use these results to bill back Reporter networking usage. The bill-back pric
structure can be based on time of day, duration, delivery location (remote s
ID), priority, and billing class. Networking messages and non-delivery 
notifications (NDN) are not reflected in this total.

Additional information

This report requires traffic OM data.

Report data

Column Description

Date The date of the networking session.

Time The time of the networking session.

Last Name The last name of the mailbox owner.

First Name The first name of the mailbox owner.

Department The department associated with the mailbox.

Mailbox The mailbox to which the networking activity is billed.

Remote Site ID The ID of the remote site to which the message was sen
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Duration (hh:mm:ss) The length of the logon session in hours, minutes, and 
seconds.

Messaging Server The CallPilot server being monitored.

Mailbox Class The mailbox class to which the mailbox is currently 
assigned.

Switch Location The name of the switch location.

Column Description
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RN Usage Bill-back Report

How to use this report

Use this report to bill the cost of outcalling activity by mailbox. Each record 
this report is a Remote Notification (RN) or Delivery to Telephone (DTT) ca
made by the specified mailbox.

Additional information
� This report requires billing OM data.

� If Department or Mailbox is specified as the primary sorting criterion fo
this report, the Call Hold Time Subtotal field appears in the printed repo

Report data

This report provides the following information:

Column Description

Name The name of the mailbox owner.

Mailbox The mailbox to which the report is billed.

Department The department number of the active mailbox.

Date The date that the call was answered.

Time The time that the call was answered.

Call Hold Time (hh:mm:ss) The length of the call.

Target DN The phone number that was the destination of the call.

Retry Counter The number of retries made to complete the call.
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Mailbox Class The mailbox class to which the mailbox is currently 
assigned.

Switch Location The name of the switch location.

Column Description
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Fax on Demand Bill-back Report

How to use this report

Use this report to charge the cost of Fax on Demand usage to the appropria
user or department. 

Additional information
� This report requires billing OM data.

� If Service DN (SDN) is specified as the primary sort criterion for this 
report, the Call Hold Time Subtotal field appears in the printed report.

Report data

Column Description

Service DN The application directory number.

Billing DN The directory number to which the bill is sent.

Date The date of the fax.

Time The time of the fax.

Call Hold Time (hh:mm:ss) The length of time of the fax in hours, minutes, and 
seconds.

Target DN The DN (phone number of the fax machine) that was th
intended destination of the fax call.

Retry Counter The number of retries at the time of the attempt. This fie
is incremented by one each time a call fails to deliver th
fax items requested.
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Call Status This field displays the result of the call, in a numeric retu
code:

1 = Could not reach destination: line busy

2 = Destination did not answer the call

3 = Unknown status

4 = Operation successful

5 = Protocol error (time-out, invalid data received, remo
system aborts session)

6 = Call was answered by a human; also detected no fa
carrier

7 = Voice parts of message delivered; fax parts exist bu
were not delivered

8 = Fax parts of message delivered; voice parts exist bu
were not delivered

9 = Invalid destination number; also site unreachable

10 = System error; unable to initiate outcalling session

11 = The destination DN is restricted

12 = The outcall was answered and the target device wa
notified

13 = All DNs in the user’s RN setup are invalid

19 = Fax parts of message delivered; voice parts exist b
were not delivered

Column Description
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Fax Print Bill-back Report

How to use this report

Use this report to bill mailbox users for the long distance charges incurred b
printing faxes to fax machines.

Additional information
� This report requires billing OM data.

� If Department or Mailbox is specified as the primary sorting criterion fo
this report, the Call Hold Time Subtotal field appears in the printed repo

Report data

This report provides the following statistical information:

Column Description

Name The name of the user.

Mailbox The number of the mailbox.

Date The date on which the faxback call was answered.

Time The time at which the faxback call was answered.

Department The number of the department to which the user belong

Call Hold Time The length of the faxback call in hours, minutes, and 
seconds.

Target DN The phone number of the fax machine that was the 
intended destination of the fax call.
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Retry Counter The number of retries at the time of the attempt. This fie
is incremented by one each time a call fails to deliver th
fax items requested.

Call Status The result of the call in a numeric return code: 

4 = Operation successful

6 = Protocol error

14 = Could not reach destination: the phone number dia
is busy

15 = Destination did not answer the call

17 = Long silence detected

18 = Voice parts of message delivered; fax parts exist b
were not delivered

19 = Fax parts of message delivered; voice parts exist b
were not delivered

22 = Invalid destination number or Bad/Invalid Address

23 = Local system error

Column Description
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Failed DTT Alert

How to use this alert

The Delivery to Telephone (DTT) service allows users to send messages to
telephone numbers that do not have mailboxes. 

Set a threshold for this alert if you want to be notified of failed message 
deliveries. This alert is triggered if the percentage of failed DTT attempts 
exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional information
� This alert requires traffic OM data.

Alert data

 

Column Description

Date The date of the failures.

Time Period The time of the failures.

New Arrivals The number of new requests that were made to the DTT
service during the time period.

Cancelled by Retry Limits The number of DTT attempts canceled due to exceeded
busy, no answer, or answered (no Dual-tone Multi-
frequency confirmation) retry limits or because the 
message became too old. 
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Investigate possible causes of failure

A high number of failed DTT sessions can indicate a problem with the DTT 
service setup. 

Suggested actions
To identify why DTT attempts are failing, run the following reports to get mo
detailed information about DTT call sessions:

� “DTT Activity Report” on page 230

� “DTT Audit Trail Summary Report” on page 234

� “DTT Audit Trail Detail Report” on page 236

See Chapter 10, “Outcalling reports.”

Cancelled by Other The number of DTT attempts that were canceled for oth
reasons. For example, DTT attempts could have been 
canceled if no channels were available.

Total Failed The total number of DTT outcalls that failed due to retry o
other causes. This number, taken as a percentage of th
total DTT outcalls, triggers the alert if the predefined 
threshold is exceeded.

Cancelled by Other The number of DTT outcalls that were canceled for othe
reasons. For example, DTT attempts could have been 
canceled if no channels were available.

Column Description
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Failed RN Alert

How to use this alert

The Remote Notification (RN) service notifies users of new messages in the
mailboxes. The RN service calls the user at a remote phone or pager, as de
by the user. This service is enabled on a per mailbox class basis. 

Set a threshold for this alert if you want to be notified of failed notifications. 
This alert is triggered if the percentage of failed RN attempts exceeds the 
specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional information

This alert requires traffic OM data.

Alert data

Column Description

Date The date of the alert.

Time Period The time period covered by the alert.

New Arrivals The number of new requests that were made to the RN 
service during the time period.

Cancelled by Retry Limits The number of RN attempts canceled due to exceeded 
busy, no answer, or answered (no DTMF confirmation) 
retry limits or because the message became too old. 
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Investigate possible causes of failure
A high number of failed RN sessions can indicate a problem with the RN ser
setup. 

Suggested actions
To identify why RN attempts are failing, run the following reports to get mor
detailed information about RN call sessions:

� “RN Activity Report” on page 256

� “RN Audit Trail Summary Report” on page 260

� “RN Audit Trail Detail Report” on page 263

See Chapter 10, “Outcalling reports.”

Cancelled by Other The number of RN attempts that were canceled for othe
reasons. For example, RN attempts might have been 
canceled if no channels were available.

Total Failed The total number of RN outcalls that failed due to retry o
other causes. This number, taken as a percentage of th
total RN outcalls, triggers the alert if the predefined 
threshold is exceeded.

Column Description
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RN Target Problem Alert

How to use this alert

Remote notifications (RNs) are sent to target telephone or pager numbers (
that are defined in users’ schedules. This alert notifies you of target DNs tha
RN service cannot successfully reach. This can happen if, for example, a u
has defined an invalid number. 

Set a threshold for this alert if you want to be notified of problems with defin
target DNs. This alert is triggered when the number of failures to a particula
target phone number exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional information

This alert requires traffic OM data.

Alert data

Column Description

Target DN The DN was not reached successfully.

Date The date of the notification failure.

Time The time of the notification failure.

Name The owner of the mailbox from which the RN attempt 
originated. 
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Investigate possible causes of failures

Too many failed outcalls to an RN target can indicate an invalid target, a pa
service outage, an RN setup problem, or user unresponsiveness.

Suggested actions

� If the failures are associated with one mailbox, contact the user and ask
or her to verify the target DN. Either you or the user must modify the 
current DN that is defined in the user’s schedule.

� If the failures to an RN target are associated with many mailboxes, this
indicate an outage at the paging service, a problem between CallPilot a
the paging service, or user unresponsiveness. To test whether the pag
service is at fault, call the service manually to see if it issues a page. 

� If the pager service appears to be working correctly, then run the RN A
Trail Detail Report to isolate the cause of the failures (see “RN Audit Tr
Detail Report” on page 263).
Reporter Guide 297



Alerts  Standard 1.0

ther 

 
als or 

 a 
d 
Failed Networking Sessions Alert

How to use this alert

This alert is useful for determining whether your CallPilot system is 
experiencing hardware or setup problems, or has insufficient capacity on ei
the local or the remote site.

Set a threshold for this alert if you want to be notified of network messaging
failures. This alert is triggered when the percentage of message failures equ
exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional information

This alert requires traffic OM data.

Alert data

Column Description

Remote Site ID The identification of the remote site where one or more 
networking calls failed.

Date The date of the networking failure(s).

Time Period The time of the networking failure(s).

Messages Attempted The total number of networking messages attempted to
particular site for the given period since the last downloa
of information.
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Investigate possible causes of failures

Too many failed network sessions indicates a networking hardware problem
setup problem, or a lack of modem capacity on the remote site.

Suggested actions

� Run the Networking Activity Report to obtain more information about th
problem (see “Networking Activity Report” on page 268).

� If failures are associated with one remote site, contact the site’s 
administrator. There can be a problem with the site’s networking setup 
hardware.

Messages Failed The total number of failed messages because the site co
not establish a network session to a particular site in the
time period specified.

Percentage of Period Total The percentage of total traffic that this service generate

Percent Failed The percentage of failed calls to the number of total 
attempted calls to a particular site.

Column Description
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Failed Fax Delivery Alert

How to use this alert

An attempt to deliver a fax is considered a failure if the complete fax item is
delivered to the target DN. 

Set a threshold for this alert if you want to be notified of unsuccessful fax 
deliveries. This alert is triggered when the percentage of failures to a partic
target fax number (DN) exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional Information

This alert requires traffic OM data.

Alert data

Column Description

Date The date of the fax delivery problem.

Time The time of the fax delivery problem.

Service DN/Mailbox If the fax originated from a mailbox this indicates the 
mailbox number. 

If the fax originated from an Application Builder service,
this indicates the SDN of the service.
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Investigate possible causes of failures

Failed fax deliveries can be due to user error, such as incorrect keying of th
number. Too many failed fax delivery sessions can also indicate a setup pro
with fax services such as Delivery to Fax.

Suggested actions
� Call the target DN to ensure that a fax modem is used to answer the ca

(fax modems issue a carrier tone that is audible). Other error possibiliti
are a busy signal or that the fax carrier is not available because the fax
machine is out of paper, not turned on, or out of order. 

� If most of the failures are associated with one channel, there can be a 
hardware problem. Run diagnostics on the channel to determine wheth
this is the case. If so, contact technical support.

� If the problem does not seem to be related to the target DN or the chan
run the following reports to help isolate the cause of failures:

� “Fax Deliveries Activity Report” on page 239

� “Fax On Demand Audit Trail Summary Report” on page 244

� “Fax On Demand Audit Trail Detail Report” on page 248

� “Fax Print Audit Trail Summary Report” on page 251

� “Fax Print Audit Trail Detail Report” on page 253

See Chapter 10, “Outcalling reports.”

Target DN  If the fax originated from a mailbox, this indicates the 
target fax number to which the user sent the fax.

If the fax originated from an Application Builder service,
this indicates the fax callback number entered by the cal

Column Description
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Excessive After-Hours Logons Alert

How to use this alert

Hackers try to gain access to mailboxes and other system resources during
nonbusiness hours, when their activity is less noticeable.

Set a threshold for this alert if you want to be notified of a high number of 
logons that occur after hours. This alert is triggered if the number of after-h
logons exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional information
� This alert requires Traffic OM data.

� Before you can use this alert, you must specify the hours during the day
your company considers after-hours, or nonbusiness hours. After-hour
defined using the Nortel Reporter program. For more information, see 
“Defining nonbusiness hours for an alert” on page 141.
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Alert data

Identify potential hacker activity

Check whether logons are being made to a particular mailbox or a number 
mailboxes. If the number of logons is very high or the duration of the logon 
sessions is long, hackers might have gained access to some mailboxes on 
system. These can be unused mailboxes hackers are using for themselves
gain access to thru-dial capabilities. Hackers can, for example, set up a sin
session over the evening to sell long-distance services.

Suggested actions

� Enable Hacker Monitor to monitor either the suspicious caller DN (refer
to as a CLID in Hacker Monitor) or the mailbox. Whenever there is a th
dial or logon from the CLID or mailbox, an alarm is generated to notify 
you.

� Check the status of the mailbox and its owner. Is the user actively using
mailbox, or is the user on vacation, or extended leave, or no longer wit
your company? 

Column Description

Mailbox The mailbox associated with the after-hours logon.

Date The date of the after-hours logon. 

Time The time of the after-hours logon. 

Duration The length of the logon session in hours, minutes, and 
seconds.

CallerDN The telephone number from which the logon originated.
This field can contain four digits (mailbox), five or six 
digits (trunk group and member number), the last seven
digits of a telephone number, or asterisks (*) if the data 
coming from the switch is null.
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� If the mailbox is unused because the user is no longer with your 
organization, delete the mailbox immediately. Hackers target unuse
mailboxes.

� If the user is temporarily away, you can either change the user’s 
password or disable the mailbox until the user returns.

� If the mailbox is active, ask the user if he or she is logging on freque
during off-hours. If the user is not the one logging on, inform him or h
of the situation and request an immediate password change. Give th
user tips on how to create secure passwords.

� Monitor the mailbox regularly.
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Excessive Thru-Dialer Access Alert

How to use this alert

Hackers break into messaging systems to access thru-dial resources. They
then place long distance calls from your system at your expense. 

Set a threshold for this alert if you want to be notified of a high number of th
dials being placed from your system. This alert is triggered if the number of
thru-dials exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150.

Additional information

This alert requires billing OM data.

Alert data

Column Description

Date The date of the alert.

Time Period The time period of the alert.

Number of Incoming Calls The number of incoming calls that placed thru-dials durin
the time period. 
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What is the source of thru-dials?

If hackers are using your system for its thru-dial capabilities, you must iden
how they are accessing thru-dial. Thru-dials can be made in a number of w
and this alert provides only a single total that does not consider how the thr
dials are made. The following features allow users and callers to make thru
dials:

� Mailbox Thru-Dialing

� Call Answering/Express Messaging Thru-Dialing

� Application Builder services that contain Thru-Dial blocks

Are thru-dials originating from mailboxes?

Do the following to determine whether thru-dials are originating from 
mailboxes: 

� Enable Hacker Monitor to monitor all mailboxes for thru-dials. This give
you a list of mailboxes with which to work.

� Enable Hacker Monitor to monitor those mailboxes that you suspect 
hackers are using for thru-dial services.

� If you suspect a hacker is using a mailbox to thru-dial, check the status
the mailbox. Is the user actively using the mailbox, or is the user on 
vacation, extended leave, or no longer with your company? 

� If the mailbox is unused because the user is no longer with your 
organization, delete the mailbox immediately. Unused mailboxes are
targets of hackers and must be removed. 

� If the user is temporarily away, you can either change the user’s 
password or disable the mailbox until the user returns.

� If the mailbox is active, ask the user to change the password 
immediately. Give the user tips on how to create secure passwords.

� Monitor the mailbox regularly.

� Check the restriction/permission list (RPL) that is assigned to the follow
features. You might need to assign a more restrictive list to prevent 
unauthorized toll calls.

� Mailbox Thru-Dialing (RPLs are assigned in mailbox classes)
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� Call Answering/Express Messaging thru-dial (the RPL is assigned in
Security Administration)

Are thru-dials from services?

Do the following to determine whether thru-dials are originating from 
Application Builder services: 

� Run the Building Block Summary Report, and make sure Thru-Dial is t
block type that will be reported on (see “Building Block Summary Repo
on page 224). You can then identify how many times the Thru-Dial bloc
in your Application Builder services have been accessed.

� Enable Hacker Monitor to monitor thru-dials from the Application Builde
services or from all services you suspect hackers are using.

� Check the services you suspect to identify the restriction/permission lis
that is assigned. You can assign a more restrictive list to prevent 
unauthorized thru-dials.
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Excessive Incomplete Messaging Accesses 
Alert

How to use this alert

One of the most common ways for hackers to gain access to a system is to 
mailbox numbers. However, hackers often enter many invalid mailbox numb
before finding one that is correct. Keep track of the number of invalid mailbo
numbers that are entered over a certain interval to help alert you to potentia
hacker activity.

Set a threshold for this alert if you want to be notified when an excessive num
of invalid mailbox numbers has been entered. This alert is triggered when t
number of invalid mailbox numbers exceeds the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150. 

Additional information

This alert requires billing OM data.

Alert data

Column Description

Date The date of the failed logons. 

Time Period The time of the failed logons. 

Total Logon Accesses The total number of logons to CallPilot. This number 
includes successful and unsuccessful logons.

Num of Logon Sessions The total number of successful logons.
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Suggested actions
Do as much as you can to increase the security of all mailboxes on your sy

� In Security Administration, check your mailbox security settings to ensu
that these precautions are in place:

� A password prefix has been defined that becomes part of the defau
password for newly created mailboxes.

� An acceptable minimum password length is defined (no less than si
characters is recommended).

� Users must change their passwords.

� Users cannot reuse the same password until they have used severa
passwords first.

� Mailboxes are temporarily locked when a certain number of invalid 
logon attempts are made.

� Secure passwords are hard for hackers to guess; remind all mailbox ow
to follow these rules when creating passwords: 

� Never use words that are in a dictionary. Combinations of letters an
numbers are more difficult to guess.

� Never use your name or other personal information, such as your bi
date or phone number.

� Never use family names or other words that can be associated with 
If you are a bird-watcher, “owl” is a bad choice for a password.

� Never let anyone borrow your password.

� Never write down your password.

� Never reuse old passwords.

� Use at least six characters in your password. 

� If you suspect a large-scale attack on many of your mailboxes, you can
temporarily disable external logons until you get the situation under 
control. This is also done in Security Administration.

Failed Accesses The total number of failed logons.

Percentage Failed The percentage of all logons that failed.

Column Description
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Excessive Failed Logons Alert

How to use this alert

One of the most common ways for hackers to penetrate a system is to gue
passwords. However, hackers often enter many invalid password before fin
one that is correct. Keep track of the number of incorrect passwords entered
a certain interval to help alert you to potential hacker activity. 

Set a threshold for this alert if you want to be notified of an excessive numb
failed logons. This alert is triggered when the number of failed logons excee
the specified threshold. 

Note: Thresholds are set using the Nortel Reporter program. For more 
information, see “Setting the threshold for an alert” on page 150. 

Additional information

This alert requires billing OM data.

Alert data

Box Description

Date The date of the failed logon.

Time The time of the failed logon.

Mailbox The mailbox with the failed logon attempt.

Caller DN The number that originated the attempt.

Number of Logons The total number of failed logons.
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Suggested actions
Do as much as you can to increase the security of all mailboxes on your sy

� In Security Administration, check your mailbox security settings to ensu
that these precautions are in place:

� A password prefix has been defined that becomes part of the defau
password for newly created mailboxes.

� An acceptable minimum password length is defined (no less than si
characters is recommended).

� Users must change their passwords.

� Users cannot reuse the same password until they have used severa
passwords first.

� Mailboxes are temporarily locked when a certain number of invalid 
logon attempts are made.

� Secure passwords are hard for hackers to guess; remind all mailbox ow
to follow these rules when creating passwords:

� Never use words that are in a dictionary. Combinations of letters an
numbers are more difficult to guess.

� Never use your name or other personal information, such as your bi
date or phone number.

� Never use family names or other words that can be associated with 
If you are a bird-watcher, “owl” is a bad choice for a password.

� Never let anyone borrow your password.

� Never write down your password.

� Never reuse old passwords.

� Use at least six characters in your password. 

� If you suspect a large-scale attack on many of your mailboxes, you can
temporarily disable external logons until you get the situation under 
control. This is also done in Security Administration.
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